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Preface 
 
 

 

The student workbook is a part of the training package developed for the vocational subject under the 

National Vocational Education Qualification Framework (NVEQF)/National Skill Qualification Framework 

(NSQF), an initiative of Ministry of Human Resource Development (MHRD), Government of India. The 

NSQF sets common principles and guidelines for a nationally recognized qualification system covering 

Schools, Vocational Education and Training Institutions, Technical Education Institutions, Colleges and 

Universities. It is envisaged that the NSQF will promote transparency of qualifications, cross-sectoral 

learning, student-centred learning and facilitate learner’s mobility between different qualifications, thus 

encouraging lifelong learning. The National Curriculum Framework, 2005 recommends that children’s life 

at school must be linked to their life outside the school. This principle makes a departure from the legacy 

of bookish learning which continues to shape our system and causes a gap between the school, home, 

community and the workplace.  

 

The Pandit Sunderlal Sharma Central Institute of Vocational Education (PSSCIVE), a constituent of 

National Council of Educational Research and Training (NCERT) has developed modular curricula and 

learning materials for the vocational subjects offered from Classes IX to XII (NSQF Levels 1-4). This 

student workbook, which has been developed keeping in view the National Occupation Standards (NOSs) 

set by the Healthcare Sector Skill Council (HSSC) for the Job Role of Vision Technician is meant for 

students who have passed Class IX or equivalent examination. The National Occupation Standards are a 

set of competency standards used for recognizing and assessing skills and knowledge needed to perform 

effectively in the workplace.  

 

The success of vocationalisation of education in schools depends on the steps that Principals and Teachers 

will take to encourage children to reflect their own learning and to pursue imaginative and on-the-job 

training activities. Participation of learners in skill development exercises and inculcation of values and 

creativity is possible if we involve children as participants in learning and not as receivers of information. 

Flexibility in the daily time-table would be a necessity to maintain the rigour in implementing the 

activities and the required number of teaching days will have to be increased for teaching vocational 

subjects. 

 

The student workbook has been developed and reviewed by a group of experts and their contributions 

are admirably acknowledged. The utility of the workbook will be adjudged by the qualitative 

improvement that it brings about in teaching-learning. The likelihood of text errors, including 

typographical errors cannot be ruled out. The feedback and suggestions on the content by the teachers 

and other stakeholders will be of immense value to us in bringing about necessary improvement in the 

student workbook.  
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About Your Workbook 

 
 
The student workbook contains sessions which will help you to acquire relevant knowledge and skills 

(generic and domain-specific skills) related to the job role. Each session is small enough to be easily 

tackled and digested by you before you move on to the next session. Animated pictures and photographs 

have been included to bring about visual appeal and to make the text lively and interactive for you. You 

can also try to create your own illustrations using your imagination or taking the help of your teacher.  

 

Let us now see what the sections in the sessions have for you. 

 

Section1: Introduction 

 

This section introduces you to the topic of the Unit. It also tells you what you will learn through the 

various sessions covered in the Unit. 

 

Section 2: Relevant Knowledge 

 

This section provides you with the relevant information on the topic(s) covered in the session. The 

knowledge developed through this section will enable you to perform certain activities. You should read 

through the information to develop an understanding on the various aspects of the topic before you 

complete the exercise(s). 

 

Section 3: Exercise 

 

Each session has exercises, which you should complete on time. You will perform the activities in the 

classroom, at home or at the workplace. The activities included in this section will help you to develop 

necessary knowledge, skills and attitude that you need for becoming competent in performing the tasks 

at workplace. The activities should be done under the supervision of your teacher or trainer who will 

guide you in completing the tasks and also provide feedback to you for improving your performance. 

 

Section 4: Assessment 

 

The review questions included in this section will help you to check your progress. You must be able to 

answer all the questions before you proceed to the next session. 
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Introduction 

 
 
 
 
 
 

 

 

In this unit, you will learn about Windows and Linux Operating 

Systems, Microsoft Word (Basic), Microsoft Excel (Basic), and the 

procedures for installing and uninstalling software on computer. 

 

An Operating System (OS) is a system software that 

manages computer hardware and software resources and provides 

common services for computer programmes. Application 

programmes usually require an operating system to function. Most 

software programmes are designed to work with just one company's 

operating system, like Windows (Microsoft) or Mac 

OS (Apple).Software developers also often release additional 

versions of their software that work with other operating systems.  

 

The history of Windows dates back to September 1981, when Chase 

Bishop, a Computer Scientist, designed the first model of an 

electronic device and project Interface Manager was started. It was 

announced in November 1983 under the name "Windows", 

but Windows 1.0 was not released until November 1985. 

 

Microsoft introduced an operating environment named Windows on 

November 20, 1985 as a graphical operating system shell for MS-

DOS in response to the growing interest in Graphical User Interfaces 

(GUIs).  

 

Microsoft Windows is a series of graphical interface operating 

systems developed, marketed and sold by Microsoft. The most 

popular operating systems today include versions of Microsoft 

Windows (like Windows 10, Windows 8, Windows 7, Windows Vista, 

and Windows XP). 

 

In 1995, Windows 95 was released which only used MS-DOS as a 

bootstrap. Windows 95 facilitated hardware installation with plug 

and play. It also brought more colours, 

enhanced multimedia capabilities and TCP/IP network 

support. Direct X began to make Windows gaming possible for more 

demanding games.  

 

Windows 98 improved speed and plug-and-play hardware 

support. USB support and quick launch made their first appearance. 

DOS gaming began to disappear as Windows gaming improved.  

 

Windows XP was released as the first NT-based system with a 

version aimed squarely at the home user. The system improved 

Window’s appearance with themes, and offered a stable platform. 

Windows XP can be said to have put an end to gaming in DOS. Direct 

X enabled features in 3D gaming that OpenGL had trouble keeping 

up with at times. XP offered the first Windows support for 64-

bit computing. However, 64-bit computing was not very well 

supported in XP, and also lacked drivers or much software to run.  
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Windows Vista had interesting visual effects but was slow to start 

and run. The 32-bit version in particular did not enable 

enough RAM for the memory-hungry OS to operate quickly. Gamers 

found the added exclusive features in Direct X 10 only mildly 

tempting compared to XP's speed.  

Windows 7 is built on the Vista kernel. Windows 7 had the visuals of 

Vista with better start up and programme speed. It was easier on 

memory and more reliable. To many end users, the biggest changes 

between Vista and Windows 7 are faster boot times, new user 

interfaces and the addition of Internet Explorer 8. The system plays 

games almost as well as XP. With true 64-bit support and an 

increasing separation in Direct X features that were not 

implemented in XP, that small performance difference benefit was 

further eroded. Windows 7 became the most used operating system 

on the Internet and also the most used for PC gaming. 

Windows 8 takes better advantage of multi-core processing, Solid 

State Drives (SSD), touch screens and other alternate input 

methods. However, users found it awkward, like switching between 

an interface made for a touch screen and one made for a mouse.  

Windows 10 was announced as the successor to Windows 8.1. It was 

released on July 29, 2015, and addresses shortcomings in the user 

interface first introduced with Windows 8. Changes include the 

Start Menu, a virtual desktop system, and the ability to run 

Windows Store apps within windows on the desktop rather than in 

full-screen mode. 

 

Linux is an operating system. It is the software on a computer that 

enables applications and the computer operator to access the 

devices on the computer to perform desired functions. Linux was 

originally developed as a free operating system for personal 

computers based on the Intel x86 architecture, but has since 

been ported to more computer hardware platforms than any other 

operating system. Linux also runs on embedded systems, which are 

devices whose operating system is typically built into 

the firmware and is highly tailored to the system; this includes 

smart phones and tablet computers running Android and other Linux 

derivatives. Development of Linux is one of the most prominent 

examples of free and open-source software collaboration. The user 

interface, also known as the shell, is either a command-line 

interface (CLI), a graphical user interface (GUI), or through 

controls attached to the associated hardware, which is common for 

embedded systems. The primary difference between Linux and 

many other popular contemporary operating systems is that 

the Linux kernel and other components are free and open-source 

software. 
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Session 1: Applications of Windows 8 and Linux Operating System 
 

In this session, you will learn about the various applications of Windows 8 and Linux operating 
system. 
 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

Windows 8 is the most significant operating system. Windows 8 was introduced with a number 

of new features across various aspects of the operating system. Among these included a 

greater focus on optimizing the operating system for touchscreen-based devices (such as 

tablets) and cloud computing. 

 

A number of apps are included in the standard installation of Windows 8, including the 

following: 

 

• Mail (an email client) 

• People (a contact manager) 

• Messaging (an IM client) 

• Calendar (a calendaring app) 

• Photos (an image viewer) 

• Music (an audio player) 

• Video (a video player) 

• Camera (a webcam or digital camera client) 

• SkyDrive 

• Reader (an e-book reader), and six other apps that expose Bing services (Search, News, 

Finance, Weather, Travel and Sports). 

 

Windows 8 also includes a Metro-style system component called PC Settings which exposes a 

small portion of Control Panel settings. Windows 8.1 improves this component to include 

more options that were previously exclusive to Control Panel. 

 

Windows 8.1 has some added features, including Calculator, Alarm Clock, Sound Recorder, 

Reading List, Food & Drink, Health & Fitness and a File Manager integrated in the SkyDrive 

app. 

 

Desktop: You can personalize the Desktop with different backgrounds, colours, and themes, 

and pin your favourite apps to the taskbar. 

 

Mail: A web application that provides message management, composition, and reception 

functions. 

 

Contact Manager: It is a software programme that enables users to easily store and finds 

contact information, such as names, addresses and telephone numbers. 

 

Instant Messaging (IM): It is a type of online chat which offers real-time text transmission 

over the Internet. 

 

Calendar: It is a time-management web application. 

 

Image viewer: An image viewer or image browser is a computer programme that can display 

stored graphical images. 

Relevant Knowledge 
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Xbox Music is a digital music service developed by Microsoft that offers music through ad-

supported streaming, subscription streaming, and purchase through the Xbox Music Store.  

 

Xbox Video: It is a digital video service developed by Microsoft that offers full HD films and 

TV shows available for rental or purchase in the Xbox Video Store. 

 

Webcam: A webcam is a video camera that feeds or streams its image in real time to or 

through a computer to computer network. 

 

OneDrive or SkyDrive: It is a file hosting service that allows users to upload and sync files 

to cloud storage and then access them from a Web browser or their local device. 

 

Start screen: Itis where you can see and quickly get to your favourite apps, people, websites, 

folders, and other things that are important to you. 

 

Search: The Search charm opens a full screen display that can be used to search through 

various sources, including Apps, Settings, Files, and content surfaced by apps. 

 

User Login: Windows 8 features a new lock screen, which includes a date and time display, 

along with the ability to display notifications from apps. 

 

Display Screen: Windows 8 includes improved support for multi-monitor configurations; the 

taskbar can now be shown on multiple displays, and each display can also show its own 

dedicated taskbar. Wallpapers can also be spanned across multiple displays, or each display 

can have its own separate wallpaper. 

 

Linux 

 

The popularity of Linux on standard desktop computers and laptops has been increasing over 

the years. Currently most distributions include a graphical user environment, with the two 

most popular environments being GNOME (which can utilize additional shells such as the 

default GNOME Shell and Ubuntu Unity), and the KDE Plasma Desktop.  

 

No single official Linux desktop exist, rather the desktop environments and Linux 

distributions select components from a pool of free and open-source software with which 

they construct a GUI implementing some more or less strict design guide. GNOME, for 

example, has its human interface guidelines as a design guide, which gives the human–

machine interface an important role, not just when doing the graphical design, but also when 

considering people with disabilities, and even when focusing on security. 

 

GNOME is one of the oldest Linux desktop environments, and certainly one of the most 

popular. GNOME—specifically GNOME Shell, the most recent iteration of the platform—has 

been designed to be easy to use, modern looking and attractive, and easy to customize and 

personalize. The break between GNOME 2 and GNOME Shell) upset many users, with several 

preferring the flatter, classic look of the DE and others preferring the more modern and less 

dated look of the most recent iteration. In any case, GNOME Shell has all the features you 

would expect from a DE, including a customizable application launcher, a top menu and 

status bar, system-wide search in the form of Dash, a window, application, and file manager, 

a notifications tray, and more. It even has window "snapping," similar to Windows 7's Aero 

Snap, support for touch pads and multi-touch gestures, and many extensions and system add-

ons, widgets, and shell themes. 
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1. Make a chart showing various types of applications available in Windows 8 
 

2. Make a presentation on the difference between Windows 8 and Linux 
 

3. Make a presentation on Linux operating system. 
 

 
 
 
I. Short Answer Questions 

 
1) Describe Mail app in Windows 8. 
 
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________ 
 
2) What is the difference between Xbox Music and Xbox Video? 
 
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________ 
 
3) What is the function of Webcam? 
 
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________ 
 
 
II. Fill in the blanks  

 
1. Application programmes usually require an _______________ system to function. 

2. Windows XP was released as the first _______________based system with a version aimed squarely 

at the home user. 

3. Windows 7 is built on the _______________ kernel. 

4. Linux is an ______________________ system. 

5. CLI stands for ________________________-Line Interface.  

6. GUI stands for _____________________ User Interface. 

7. Mail is a web application that provides ____________________ management, composition and 

reception functions. 

 

 

 

 

 

Exercise 
 

Assessment  
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Use the following checklist to see if you have met all the requirements for assessment activity: 
 

 
Part – A 
 

Differentiated between the following: 
 

Windows and Linux Operating System 
 
Part – B 
 

Discussed in class the following: 
 

1. What are the various security features of Windows 8? 
2. What are the various security features of Linux? 
3. How Windows OS differs from Linux?  
 
Part – C 
 

Performance Standards 
 

The performance standards may include but not limited to: 
 

Performance Standards Yes No 

Demonstrated the knowledge of using Windows 8   

Integrated a range of Windows 8 features into their learning activities   

Demonstrated the knowledge of key features of Linux OS   

 
  

Checklist for Assessment Activity 
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Session 2: MS Word  
 

In this session, you will learn about the application of various features and functions of MS Word. 
 
 
 
 
MS WORD 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 

Microsoft Word is the word processor component of Microsoft Office 

that allows users the ability to create and save documents. A word 

document can be a letter, report, or even a web page. 

 

To Start Microsoft Word 

 

Click on the Start button on the left side of the taskbar; then click 

Programmes; then click Microsoft Word. 

 

Creating a Blank Document 

 

Select New from under the File Menu. 

 

A Blank document should appear on screen. If not, choose Blank 

from under the Task Pane on the right side of the page. 

 
Formatting Text 
 
To format font size: 

 

Select the text you want to modify. 

Left-click the drop-down arrow next to the font size box on the 
Home tab. The font size drop-down menu appears. 

 

Move your cursor over the various font sizes. A live preview of the 
font size will appear in the document. 

 
Left-click the font size you want to use. The font size will change in 
the document. 

 
To format font style: 
 
Select the text you want to modify. 

Left-click the drop-down arrow next to the font style box on the 
Home tab. The font style drop-down menu appears. 

Move your cursor over the various font styles. A live preview of he 
font will appear in the document. 

 
Left-click the font style you want to use. The font style will change 
in the document. 

To use the bold, italic, and underline commands: 
 

Select the text you want to modify. 

Click the bold, italic, or underline command in the Font group on 
the Home tab. 

 

 

 

Relevant Knowledge 
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To change the text case: 
 
Select the text you want to modify. 

Click the Change Case command in the Font group on the Home 
tab. 

Select one of the case options from the list. 

To change text alignment: 

Select the text you want to modify. 

Select one of the four alignment options from the Paragraph group 

on the Home tab. 

Align Text Left: Aligns all of the selected text to the left margin 

Center: Aligns text an equal distance from the left and right 

margins 

Align Text Right: Aligns all of the selected text to the right margin 

Justify: Aligns text equally to the right and left margins; used in 

many books, newsletters, and newspapers 

 
To format font color: 

 

Select the text you want to modify. 

Left-click the drop-down arrow next to the font color box on the 
Home tab. The font color menu appears. 

Move your cursor over the various font colors. A live preview of the 
color will appear in the document. 

Left-click the font color you want to use. The font color will change 
in the document. 

Your color choices aren't limited to the drop-down menu that 
appears. Select More Colors at the bottom of the list to access the 
Colors dialog box. Choose the color you want, then click OK. 

Creating WordArt 

In addition to adding effects to a text box, you can add effects to 

the text inside the text box, which is known as WordArt.  

To convert regular text into WordArt: 

For text to be formatted as WordArt, it must be inside a text box. 

However, there is a shortcut that allows you to convert text into 

WordArt even if it's not in a text box. 

Select the text you want to convert, then click the Insert tab. 

Click the WordArt drop-down arrow in the Text group. A drop-down 

menu of WordArt styles will appear. Select the style you want to 

use. 
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Word will automatically create a text box for the text, and the text 
will appear in the selected style. If you want, you can change 
the font or font colour from the Home tab. 

 
Insert a picture or clip art 

Pictures and clip art can be inserted or copied into a document from 
many different sources, including downloaded from a clip art Web 
site provider, copied from a Web page, or inserted from a file where 
you save pictures. 

You can also change how a picture or clip art is positioned with text 
within a document. 

Insert clip art 

On the Insert tab, in the Illustrations group, click Clip Art.  

In the Clip Art task pane, in the Search for text box, type a word 
or phrase that describes the clip art that you want, or type in all or 
some of the file name of the clip art.  

To narrow your search, do one or both of the following:  

 

To limit the search results to a specific collection of clip art, in the 
Search in box, click the arrow and select the collection you want to 
search.  

 

To limit the search results to clip art, click the arrow in the Results 
should be box and select the check box next to Clip Art.  

In the Clip Art task pane, you can also search for photographs, 
movies, and sounds. To include any of those media types, select the 
check boxes next to them. 

Click Go.  

In the list of results, click the clip art to insert it. 

Adding SmartArt Graphic 

A SmartArt graphic is a visual representation of your information 

that you can quickly and easily create, choosing from among many 

different layouts, to effectively communicate your message or 

ideas. 

Create a SmartArt graphic and add text to it 

On the Insert tab, in the Illustrations group, click Smart Art. 

In the Choose a SmartArt Graphic dialog box, click the type and 
layout that you want. 

Enter your text by doing one of the following: 
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Click [Text] in the Text pane, and then type your text. 

Copy text from another location or program, click [Text] in the Text 
pane, and then paste your text.If the Text pane is not visible, click 
the control. 

To add text in an arbitrary position close to or on top of your 
SmartArt graphic, on the Insert tab, in the Text group, click Text 
Box to insert a text box. If you want only the text in your text box 
to appear, right-click your text box, click Format Shape or Format 
Text Box, and then set the text box to have no background color 
and no border. 

Click in a box in the SmartArt graphic, and then type your text. For 
best results, use this option after you add all of the boxes that you 
want. 

Add or delete shapes in your SmartArt graphic 

Click the SmartArt graphic that you want to add another shape to. 

Click the existing shape that is located closest to where you want 
to add the new shape. 

Under SmartArt Tools, on the Design tab, in the Create 
Graphic group, click the arrow under Add Shape. 

If you don't see the SmartArt Tools or Design tabs, make sure that 
you've selected the SmartArt graphic. You may have to double-click 
the SmartArt graphic to open the Design tab. 

Do one of the following: 

To insert a shape after the selected shape, click Add Shape After. 

To insert a shape before the selected shape, click Add Shape 
Before. 

Change the colors of an entire SmartArt graphic 

You can apply color variations that are derived from the theme 
colors to the shapes in your SmartArt graphic. 

Click your SmartArt graphic. 
Under SmartArt Tools, on the Design tab, in the SmartArt  

Styles group, click Change Colors 

Align the text left or right 

Select the text that you want to align.  

On the Home tab, in the Paragraph group, click Align Left or 

Align Right  
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Center the text 

Select the text that you want to center.  

On the Home tab, in the Paragraph group, click Center  

Justify the text 

You can justify the text, which might make the last line of text in a 
paragraph considerably shorter than the other lines. 

Select the text you want to justify.  

On the Home tab, in the Paragraph group, click Justify  

 
Inserting Symbols 

In Microsoft Office Word 2007, you can insert mathematical symbols 
into equations. 

On the Insert tab, in the Symbols group, click the arrow next to 
Equations, and then click Insert New Equation.  

Under Equation Tools, on the Design tab, in the Symbols group, 

click the More arrow .  

Click the arrow next to the name of the symbol set, and then click 
the name of the symbol set that you want to display.  

Click the symbol that you want to insert. 

 
Inset Page Borders 
 
You can apply a simple line border or a more complex line style to 
your document. These line borders can give your document a 
professional appearance. 

Click Box in the Settings section if it is not already selected. This 

will apply the border to the entire page. If you only want the border 

in a certain location, such as the top and the bottom of the pages, 

click Custom. 

Select a Line Style from the Style section in the middle of the 

screen 

Scroll down through the list to view different line styles. 

Select a Line Color from the Color drop-down menu. 

Select a Line Width from the Width menu. 

To customize where the border appears, click the appropriate 

button on the Preview section or click on the border itself on 

the Preview image. This toggles the border off and on. 

Select which pages to apply the border to in the Apply To drop-

down menu. While this list varies depending on what is in your 

document, common choices include Whole Document, This Page, 

Selected Section, and This Point Forward. 

Click OK. The line border is applied to your document. 
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Adding a New Table And/or Rows to a Word Document: Creating 

Tables (Method 1) 

 

Select TABLE from the Menu bar. 

Using the drop-down menu select Insert Table. 

Fill in the Number of Columns field with the correct number for the 

table you want to create, 

Fill in the Number of Rows field with the correct number for the 

table you want to create. 

If you want each column to be a certain width, enter that width in 

the column width field. If you want the computer to determine how 

wide each column is, select AUTO in this field. 

Click OK. A table should appear in your document and should be 

ready for you to complete with your information. 

 

Creating Tables (Method 2) 

 

Select the Insert Table icon on the toolbar (If your cursor is currently 

located within a table you will not be able to locate the Insert Table 

icon. If this happens move your cursor outside the table in your 

document). 

Use your mouse to highlight the number of rows and columns you 

need in your table. The maximum table size is 5 columns by 4 rows. 

If you need a larger table use Method 1 above. 

Press Enter. 

 

Once you have created a table you can move among cells(blocks in 

a table) using either the Tab key (moves you left to right), the 

Shift+Tab key (moves you right to left) or the arrow keys. You may 

also use your mouse to click directly on a cell. You enter data in the 

table by typing just as you would in any document. 

 

To add a row to the bottom of a table you have already created 

 

Select the cell located at the lower right corner of your table (the 

last column of the last row) and then press the Tab key. If you want 

to add a row in the middle of a table you have already created: 

Select any cell on the row just below where you want to add a new 

row. 

Select Table from the menu bar. 

Select Insert Rows from the drop-down menu and press enter. 

 

To add a column to a table you have already created 

 

Place your cursor anywhere in the column immediately to the right 

of where you want to insert a column. 

Choose Table from the menu bar. 

Choose Select Column from the drop-down menu. 

Press enter. 

Select Table from the menu bar. 

Choose Insert Columns from the drop-down menu. 

Press enter. 
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A new column should appear in your table. 

 

To change the width of columns in a table you have already 

created 

 

Select any cell in your table. 

Select Table from the menu bar. 

Choose Select Table from the drop-down menu. 

Press enter. 

Select Table from the menu bar again. 

Choose Cell Height and Width from the drop-down menu. 

Press enter. 

Select the tab labelled Column. 

Enter a number in the Width of Columns field. 

Click on OK. 

All of your columns will now be the same specified width 

(For example, if you enter 1, each column will be 1 inch wide). 

 

If you want columns to be different widths 

 

Place your cursor anywhere in the column you want to change. 

Select Table from the menu bar. 

Choose Select Column from the drop-down menu. 

Press enter. 

Select Table from the menu bar. 

Choose Cell Height and Width from the drop-down menu. 

Press enter. 

Select the tab labelled Column and enters the desired width in the 

Width of Column field. 

Click OK. 

 

There is an alternate method of changing width of columns. You can 

also change the width of columns by placing your cursor on the line 

between two columns. While doing this the width indicator will 

appear. You can then left-click and drag your mouse to change the 

width of columns. 

 

Click anywhere on your table. 

Select Table from the menu bar. 

Choose Sort from the drop-down menu. 

Press enter. 

Select the heading of the column you wish to use in sorting your 

table. 

Choose whether you are sorting text or numbers. 

Choose whether you wish to sort in ascending or descending order. 

If you wish to sort by a second column choose that column heading 

in the Then By field. You then choose text or number and ascending 

or descending for this secondary sort. 

If your table has heading in the first row you should select Header 

Row so that row will not be sorted. 

Click OK 

. 
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You can delete rows or columns 

 

Select any cell in the row or column you wish to delete. 

Select Table from the menu bar. 

Choose Select Row or Select Column from the drop-down menu. 

Press enter. 

Select Table from the menu bar again. 

Choose Delete Row or Delete Column from the drop-down menu. 

Press enter. 

 

Set Page Orientation 

Change the orientation of your entire document 

On the Page Layout tab, in the Page Setup group, click 
Orientation. 

 

Click Portrait or Landscape.  

Use portrait and landscape orientation in the same document 

Select the pages or paragraphs that you want to change to portrait 
or landscape orientation.  

On the Page Layout tab, in the Page Setup group, click Margins.  

Click Custom Margins.  

On the Margins tab, click Portrait or Landscape.  

In the Apply to list, click Selected text.  

 
Insert Header and Footer 

Insert a predefined header or footer 

On the Insert tab, in the Header & Footer group, click Header or 
Footer.  

Click the header or footer design that you want.  

The header or footer is inserted on every page of the document. 

Insert a Page Number 

If your document already has content in the header or footer, you 
can add the page number to the header or footer. 

If you want to use one of the preformatted page number designs, 
but you want more information in the header or footer than just the 
page number, it is easiest to start with a page number and then add 
other text or graphics to the header or footer. 

Add a page number to an existing header or footer 

Double-click the header or footer area.  

Position the cursor where you want to insert the page number.  

On the Insert tab, in the Header & Footer group, click Page 
Number.  



25 | P a g e  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click Current Position.  

Choose a page number design from the gallery of designs.  

 
Insert Charts 

On the Insert tab, in the Illustrations group, click Chart. 

In the Insert Chart dialog box, click the arrows to scroll through the 

chart types. 

Select the type of chart that you want and then click OK. 

When you rest the mouse pointer over any chart type, a ScreenTip 

displays its name. 

When you are finished editing your data, you can close Excel. 

Modify Line Spacing  

Change the line spacing in an existing document 

The easiest way to change the line spacing for an entire document 
is to apply a Quick Style set that uses the spacing that you want. If 
you want to change the line spacing for a portion of the document, 
you can select the paragraphs and change their line spacing 
settings. 

Use a style set to change line spacing for an entire document 

On the Home tab, in the Styles group, click Change Styles. 

Point to Style Set, and point to the various style sets. Using the live 
preview, notice how the line spacing changes from one style set to 
the next.  

For example, the Traditional and Word 2003 style sets use single-
spacing. The Manuscript style set uses double spacing. 

When you see spacing that you like, click the name of the style set. 

Change the line spacing in a portion of the document 

Select the paragraphs for which you want to change the line 
spacing. 

On the Home tab, in the Paragraph group, click Line Spacing.  

Do one of the following:  

Click the number of line spaces that you want.  

For example, click 2.0, to double-space the selected paragraph. 
Click 1.0 to single-space with the spacing that is used in earlier 
versions of Word. Click 1.15 to single-space with the spacing that is 
used in Word 2007. 
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Click Line Spacing Options, and then select the options that you 
want under Spacing. See the following list of available options for 
more information.  

Line spacing options 

Single:  This option accommodates the largest font in that line, plus 
a small amount of extra space. The amount of extra space varies 
depending on the font that is used.  

1.5 lines:  This option is one-and-one-half times that of single line 
spacing.  

Double:  This option is twice that of single line spacing.  

At least:  This option sets the minimum line spacing that is needed 
to fit the largest font or graphic on the line.  

Exactly:  This option sets fixed line spacing, expressed in points. 
For example, if the text is in a 10-point font, you can specify 12 
points as the line spacing.  

Multiple:  This option sets line spacing that can be expressed in 
numbers greater than 1. For example, setting line spacing to 1.15 
will increase the space by 15 percent, and setting line spacing to 3 
increases the space by 300 percent (triple spacing).  

Change the spacing before or after paragraphs 

The easiest way to change the spacing between paragraphs for an 
entire document is to apply a Quick Style set that uses the spacing 
that you want. If you want to change the spacing between 
paragraphs for a portion of the document, you can select the 
paragraphs and change their spacing-before and spacing-after 
settings. 

Use a style set to change paragraph spacing for an entire 
document 

On the Home tab, in the Styles group, click Change Styles..  

Point to Style Set, and point to the various style sets. Using the live 
preview, notice how the line spacing changes from one style set to 
the next.  

For example, the Word 2003 style set inserts no extra space 
between paragraphs and a small amount of space above headings. 
The Word 2007 style set uses a double space between paragraphs 
and adds more space above headings. 

When you see spacing that you like, click the name of the style set. 

Change the spacing before and after selected paragraphs 

By default, paragraphs are followed by a blank line, and headings 
have extra space above them. 

Select the paragraph before or after which you want to change the 
spacing.  

On the Page Layout tab, in the Paragraph group, click an arrow 
next to Spacing Before or Spacing After and enter the amount of 
space that you want.  

javascript:AppendPopup(this,'offont_1_1')
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Set the default to single-spacing for all new documents 

On the Home tab, in the Styles group, click Change Styles..  

Point to Style Set, and click Word 2003. 

 
Create a bulleted or numbered list 
 

You can quickly add bullets or numbers to existing lines of text, or 
Word can automatically create lists as you type. 

By default, if you start a paragraph with an asterisk or a number 1., 
Word recognizes that you are trying to start a bulleted or numbered 
list. If you don't want your text turned into a list, you can click the 

AutoCorrect Options button that appears. 

Lists: One level or many levels 

Make a list with just one level, or make a multilevel list to show lists 
within a list. 

When you create a bulleted or numbered list, you can do any of the 
following: 

Use the convenient Bullet and Numbering libraries   

Use the default bullet and numbering formats for lists, customize 
the lists, or select other formats from the Bullet and Numbering 
libraries. 

Format bullets or numbers:  Format bullets or numbers differently 
from the text in a list. For example, click a number and change the 
number color for the entire list, without making changes to the text 
in the list. 

Use pictures or symbols:   Create a picture bulleted list to add 
visual interest to a document or a Web page. 

Create a one-level bulleted or numbered list 

Word can automatically create bulleted and numbered lists as you 
type, or you can quickly add bullets or numbers to existing lines of 
text. 

Add bullets or numbering to a list 

Select the items that you want to add bullets or numbering to.  

On the Home tab, in the Paragraph group, click Bullets or 
Numbering.  

 

Checking for spelling and grammatical mistakes 

 

Spell checking is a unique facility in MS Word. 

When you have typed your document, select Tools from the menu 

bar. 



28 | P a g e  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 

Choose Spelling and Grammar from the drop-down menu. 

The computer will alert you to spelling or grammatical mistakes 

within your document. You may either Skip the reported problems 

or elect to replace the reported problem with the computer's 

suggestion or with some other change by entering it in the 

suggestion field. 

 

Saving a Word Document 

 

To save a new document, select File from the menu bar. 

Choose Save from the drop-down menu. 

Select the location to which you wish to save the document from 

the drop-down menu at the top of the save box. 

Enter the name of the document you are saving. This will be the 

way you identify the document on your computer or disk. 

Select the type of file you are saving from the drop-down menu at 

the bottom of the save box. This will usually be Word Document. 

Click Save. 

 

Printing a document 

 

Select File from the menu bar. 

Choose Print from the drop-down menu. 

Select the printer that you are printing to from the drop-down 

menu. 

Select whether you want to print the entire document, only the 

current page, selected pages (ex. 3-8 or 3, 4, 10 will print pages 3 

through 9 or pages 3, 5 and 9), or a portion of the text you have 

highlighted. 

Select how many copies you want to print. 

Click OK. 

 

Inkjet Printer and Laser Printer 

 

Getting Help in Microsoft Word  
 
Microsoft Word users can find the help button (?) at the top right 

hand corner of the application. and keyboard shortcut for accessing 

help is F1 

 

The option to choose Online or Offline help can be done by clicking 

down the arrow available below Word Help. 

 
Go to computer laboratory of your school and open MS Word. Create 
a table and name it. Enter data depicting your activities from 
Monday through Saturday. Write the days in the first column and 
activities along the header row. Do not forget to save the file. 
 
On next day open the same file and insert one more row for Sunday. 
Start inserting data in all the cells. If you feel, change the row 
length or column heights. You may like to ‘wrap’ any text. Carry out 
spell checking. 
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Short Answer Questions 
 
Write the steps for the following: 
 
(a) Inserting a row in the table 
 
_______________________________________________________________________________________
_______________________________________________________________________________________
_______________________________________________________________________________________ 
 
(b) Inserting a column in the table 
 
_______________________________________________________________________________________
_______________________________________________________________________________________
_______________________________________________________________________________________
_______________________________________________________________________________________ 
 
 

 
 
Use the following checklist to see if you have met all the requirements for assessment activity. 
 
Part – A 
 
Differentiated between the following: 
 
1. Inserting a row and inserting a column in a table 
2. Copy-paste and cut-paste 
3. Page break and section break 
 
Part B 
 
Discussed in class the following: 
 
1.  How to insert a page? 

2.  How to insert page and section break? 

3.  Why should we use print preview before printing a document? 

 
Part - C 
 
Performance Standards 
 
The performance standards may include, but not limited to: 
 

Performance Standards Yes No 

Demonstrated the skill of using different commands for editing a document on MS 

Word 

  

Demonstrated the skill of using select, copy, paste, delete and save commands in 

MS Word 

  

 

 Checklist for Assessment Activity 

Assessment  
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Microsoft Excel (MS Excel) allows versatile facilities for work related 

to mathematics, statistics, basic calculations, etc. If the software 

has been installed on your desktop, you will see an icon of MS Excel. 
 

If you do not find that then follow the steps: 

 

Click Start>Programmes>Microsoft Office>Microsoft Excel 2010 

The Ribbon- seen across the top of Microsoft Excel. The ribbon 

contains Tabs, Groups, and Commands  

Tabs – sit across the top of the ribbon. Each tab contains core tasks 

you do in the programme (Home, Insert, Page Layout etc.)  

Groups – sets of related commands displayed in the tabs. 

(Clipboard, Font, Alignment, Number, Styles etc.) 

Commands – a button, menu, or a box where you enter information. 

View the figure below. 

 

Each square on the worksheet is called a cell. Enter (type) your 

data into each cell. Its location is determined by the column 

letter and row number. In the example below, January is typed in 

cell “C3”. After you enter the date, press the Enter key on your 

keyboard. So, Excel accepts what you typed.View the figure on 

the left side. 

 

Type in a title, column headings, and row headings for your data 

you wish to enter.See the figure below for clarity as an example. 

 

 
Formulas are used to calculate cells. All formulas must begin with 

an equals (=) sign. Also, when creating formulas, use the cell 

location, not what is in the cell to create your formula. 

 

 

 

 

Relevant Knowledge 
 

Session 3: MS Excel               

In this session, you will learn about MS Excel. 
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a. Example:  =C4+D4+E4 

  
 

b. After you type in the formula, press the [Enter] key on your 

keyboard. The formula will be replaced by the result in that cell. 

 

 
 

Functions are prewritten formulas. The most common functions 

are Sum, Average, Minimum, and Maximum. To Sum (add up 

cells), click on the cell you wish to place the function. On the 

toolbar, click on the AutoSum button. 

 

You will notice a marquee around some cells that Excel thinks you 

want to add. If Excel guesses correctly, just press the [Enter] key. 

If Excel does not guess the correct cells you want to add, click and 

drag over the cells you want and then press the [Enter] key. 

 

 
 

To find the Average, Minimum, or Maximum, click on the cell you 

wish to place the function. On the toolbar, click the little drop 

down arrow next to the AutoSum button. Select the function by 

clicking on it. 

 

You will notice a marquee around some cells that Excel thinks you 

want to use. If Excel guesses correctly, just press the [Enter] key. 

If Excel does not guess the correct cells you want, drag over the 

cells you want and then press the [Enter] key. 

 

Save your workbook. Save early, save often! Once you type in 

some data, it is a good time to save your work. When you save 

your work, you need to tell Excel where to save the file and what 

to name it. 
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Click the File Tab located on the upper left corner. 

 
i.Select Save As 

ii.The Save As Dialog Box appears 

 

Change the Save in box to the location where you wish to save 

your document (3 ½ inch Floppy drive, a Flash drive...) 

In the File Name Box, type in the name of your document 

Click the Save button 

 

Then give the workbook a name. Microsoft may offer you a 

suggested name. You can delete it and type in any name you wish. 

 

Then click the Save button. 

 

Formatting Cells 

 

Formatting cells allows you to change the size, colour, alignment, 
and font type you want. Select the cells and click the appropriate 
button. 
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Excel XP and Excel 2003 

 
 

Excel 2007 

 
 

 

Excel 2010 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Set Page Orientation: 

 

To change page orientation in Excel 2007 follow the steps given 

below: 

 

 Switch to the Page Layout tab. 

 In the Page Setup group click Orientation. 

 

Select the required orientation (Portrait or Landscape) from the 

options shown. 

 

Merging of the Cells: 

 

Merging cells is often used when a title is to be centred over a 

particular section of a spreadsheet. When a group of cells is 

merged, only the text in the upper-leftmost box is preserved. 

 

To merge a group of cells: 

 

Highlight or select a range of cells. 

Right-click on the highlighted cells and select Format Cells. 

Click the Alignment tab and place a checkmark in the checkbox 

labelled Merge cells. 

 

To merge a group of cells and centre the text, you can also use 

the Merge and Centre button on the Excel tool bar. Again, this 

will only preserve the text in the upper-leftmost cell. 

 

Highlight or select a range of cells. 

 

Click the Merge and Centre button on the toolbar. 

Excel XP and Excel 2003, Excel 2007,Excel 2010,Excel 2013 

 

Insert blank cells on a Worksheet 

Select the cell or the range of cells where you want to insert the 

new blank cells. Select the same number of cells as you want to 

insert. For example, to insert five blank cells, select five cells. 

To cancel a selection of cells, click any cell on the worksheet. 

For more information about making selections, see Select cells, 

ranges, rows, or columns later in this topic. 

Do one of the following: 

Right-click the selected cells and then click Insert. 

On the Home tab, in the Cells group, click the arrow below to 

Insert, and then click Insert Cells. 

https://support.office.microsoft.com/client/Select-cells-ranges-rows-or-columns-b6982f0b-a707-4282-a59d-65a3b47fafa3#bkmk_selectcellsranges
https://support.office.microsoft.com/client/Select-cells-ranges-rows-or-columns-b6982f0b-a707-4282-a59d-65a3b47fafa3#bkmk_selectcellsranges
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In the Insert dialog box, click the direction in which you want to 

shift the surrounding cells. 

When you insert cells on a worksheet, the references adjust 

accordingly, whether they are relative or absolute cell references. 

The same behaviour applies to deleting cells, except when a 

deleted cell is directly referenced by a formula. If you want 

references to adjust automatically, it's a good idea to use range 

references when you can in your formulas, instead of specifying 

individual cells. 

You can insert cells that contain data and formulas by copying or 

cutting the cells, right-clicking the location where you want to 

paste them, and then clicking Insert Copied Cells or Insert Cut 

Cells. 

Insert rows on worksheet 

 

Do one of the following: 

 

To insert a single row, select either the whole row or a cell in the 

row above which you want to insert the new row. For example, to 

insert a new row above row 5, click a cell in row 5. 

 

To insert multiple rows, select the rows above which you want to 

insert rows. Select the same number of rows as you want to 

insert. For example, to insert three new rows, you select three 

rows. 

To insert nonadjacent rows, hold down Ctrl while you select 

nonadjacent rows. 

To cancel a selection of cells, click any cell on the worksheet. 

For more information about making selections, see Select cells, 

ranges, rows, or columns later in this topic. 

Do one of the following: 

Right-click the selected cells and then click Insert. 

On the Home tab, in the Cells group, click the arrow under Insert, 

and then click Insert Sheet Rows. 

Insert column on worksheet 

Do one of the following: 

To insert a single column, select the column or a cell in the 

column immediately to the right of where you want to insert the 

new column. For example, to insert a new column to the left of 

column B, click a cell in column B. 

To insert multiple columns, select the columns immediately to the 

right of where you want to insert columns. Select the same 

https://support.office.microsoft.com/client/Select-cells-ranges-rows-or-columns-b6982f0b-a707-4282-a59d-65a3b47fafa3#bkmk_selectcellsranges
https://support.office.microsoft.com/client/Select-cells-ranges-rows-or-columns-b6982f0b-a707-4282-a59d-65a3b47fafa3#bkmk_selectcellsranges
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number of columns as you want to insert. For example, to insert 

three new columns, you select three columns. 

To insert nonadjacent columns, hold down Ctrl while you select 

nonadjacent columns. 

To cancel a selection of cells, click any cell on the worksheet. 

For more information about making selections, see Select cells, 

ranges, rows, or columns later in this topic. 

Do one of the following: 

Right-click the selected cells and then click Insert 

On the Home tab, in the Cells group, click the arrow under Insert, 

and then click Insert Sheet Columns. 

Delete cells, rows, and columns 

To cancel a selection of cells, click any cell on the worksheet. 

For more information about making selections, see Select cells, 

ranges, rows, or columns later in this topic. 

On the Home tab, in the Cells group, click the arrow next to 
Delete, and then do one of the following: 

To delete selected cells, click Delete Cells. 

To delete selected rows, click Delete Sheet Rows. 

To delete selected columns, click Delete Sheet Columns. 

You can right-click a selection of cells, click Delete, and then 

click the option that you want. You can also right-click a selection 

of rows or columns and then click Delete. 

If you are deleting a cell or a range of cells, in the Delete dialog 

box, click Shift cells left, Shift cells up, Entire row, or Entire 

column. 

If you are deleting rows or columns, other rows or columns 

automatically shift up or to the left. 

Tips     

To repeat deleting cells, rows, or columns, select the next cells, 

rows, or columns, and then press Ctrl+Y. 

If needed, you can restore deleted data immediately after you 

delete it. On the Quick Access Toolbar, click Undo Delete, or 

press Ctrl+Z. 

Pressing the Delete key deletes the contents of the selected cells 

only, not the cells themselves. 

https://support.office.microsoft.com/client/Select-cells-ranges-rows-or-columns-b6982f0b-a707-4282-a59d-65a3b47fafa3#bkmk_selectcellsranges
https://support.office.microsoft.com/client/Select-cells-ranges-rows-or-columns-b6982f0b-a707-4282-a59d-65a3b47fafa3#bkmk_selectcellsranges
https://support.office.microsoft.com/client/Select-cells-ranges-rows-or-columns-b6982f0b-a707-4282-a59d-65a3b47fafa3#bkmk_selectcellsranges
https://support.office.microsoft.com/client/Select-cells-ranges-rows-or-columns-b6982f0b-a707-4282-a59d-65a3b47fafa3#bkmk_selectcellsranges
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Excel keeps formulas up to date by adjusting references to the 

shifted cells to reflect their new locations. However, a formula 

that refers to a deleted cell displays the #REF! Error value. 

Select cells, range, rows or columns 

To select Do this 

A single cell 
Click the cell, or press the arrow keys to move to  
the cell. 
 

 

A range of cells 

Click the first cell in the range, and then drag to  
the last cell, or hold down Shift while you press  
the arrow keys to extend the selection. 
 
You can also select the first cell in the range, and  
then press F8 to extend the selection by using  
the arrow keys. To stop extending the selection,  
press F8 again. 
 

A large range of cells 
Click the first cell in the range, and then hold  
down Shift while you click the last cell in the range.  
You can scroll to make the last cell visible. 

All cells on a worksheet 

Click the Select All button.  

 

To select the whole worksheet, you can also press Ctrl+A. 

If the worksheet contains data, Ctrl +A selects the current region. Pressing Ctrl +A again 
selects the whole worksheet. 

Nonadjacent cells or cell 
ranges 

Select the first cell or range of cells, and then hold down Ctrl while you select the other 
cells or ranges. 

You can also select the first cell or range of cells, and then press Shift+F8 to add another 
nonadjacent cell or range to the selection. To stop adding cells or ranges to the selection, 
press Shift+F8 again. 

You can’t cancel the selection of a cell or range of cells in a nonadjacent selection without 
canceling the whole selection. 

A whole row or 
column 

Click the row or column heading. 

 

 

Row heading 

2. Column heading 
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You can also select cells in a row or column by selecting the first cell and then pressing 
Ctrl+Shift+Arrow key (Right Arrow or Left Arrow for rows, Up Arrow or Down Arrow for 
columns). 

If the row or column contains data, Ctrl+Shift+Arrow key selects the row or column to the 
last used cell. Pressing Ctrl+Shift+Arrow key again selects the whole row or column. 

Adjacent rows or 
columns 

Drag across the row or column headings. Or select the first row or column. Then hold down 
Shift while you select the last row or column. 

Nonadjacent rows or 
columns 

Click the column or row heading of the first row or column in your selection. Then hold 
down Ctrl while you click the column or row headings of other rows or columns that you 
want to add to the selection. 

The first or last 
cell in a row or 
column 

Select a cell in the row or column, and then press Ctrl+Arrow key (Right Arrow or Left  
Arrow for rows, Up Arrow or Down Arrow for columns). 

The first or last cell 
on a worksheet or in 
a Microsoft Office 
Excel table 

Press Ctrl+Home to select the first cell on the worksheet or in an Excel table. 

Press Ctrl+End to select the last cell on the worksheet or in an Excel table that contains data 
or formatting. 

Cells to the last used 
cell on the 
worksheet (lower-
right corner) 

Select the first cell, and then press Ctrl+Shift+End to extend the selection of cells to the last 
used cell on the worksheet (lower-right corner). 

Cells to the 
beginning of the 
worksheet 

Select the first cell, and then press Ctrl+Shift+Home to extend the selection of cells to the 
beginning of the worksheet. 

More or fewer cells 
than the active 
selection 

Hold down Shift while you click the last cell that you want to include in the new selection. 
The rectangular range between the active cell and the cell that you click becomes the new 
selection. 

 

ii. Design Text 

 

TEXT function 

 

The TEXT function lets you change the way a number appears by 

applying formatting to it with format codes. It's useful in 

situations where you want to display numbers in a more readable 

format, or you want to combine numbers with text or symbols.  

 

Syntax 

 

TEXT(value, format text) 

The TEXT function syntax has the following arguments: 

Argument Name Description 

value A numeric value that you want to be converted into text. 

Format text A text string that defines the formatting that you want to be applied to the supplied value. 

Overview 



38 | P a g e  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In its simplest form, the TEXT function says: 

 

=TEXT(Value you want to format, "Format code you want to apply") 

Here are some popular examples, which you can copy directly into 

Excel to experiment with on your own. Notice the format codes 

within quotation marks.  

Formula Description 

=TEXT(1234.567,"$#,##
0.00") 

Currency with a thousands separator and 2 decimals, like $1,234.57.  
Note that Excel rounds the value to 2 decimal places. 

=TEXT(TODAY(),"MM/DD
/YY") 

Today’s date in MM/DD/YY format, like 03/14/12 

=TEXT(TODAY(),"DDDD") Today’s day of the week, like Monday 

=TEXT(NOW(),"H:MM 
AM/PM") 

Current time, like 1:29 PM 

=TEXT(0.285,"0.0%") Percentage, like 28.5% 

=TEXT(4.34 ,"# ?/?") Fraction, like 4 1/3 

=TRIM(TEXT(0.34,"# 
?/?")) 

Fraction, like 1/3. Note this uses the TRIM function to remove the leading space 
with a decimal value. 

=TEXT(12200000,"0.00E
+00") 

Scientific notation, like 1.22E+07  

=TEXT(1234567898,"[<=
9999999]###-
####;(###) ###-####") 

Special (Phone number), like (123) 456-7898 

=TEXT(1234,"0000000")  Add leading zeros (0), like 0001234 

=TEXT(123456,"##0° 00' 
00''") 

Custom - Latitude/Longitude 

 

Insert symbol 

Click where you want to insert the symbol. 

On the Insert tab, in the Symbols group, click Symbol. 

Do one of the following: 

Click the symbol that you want in the drop-down list. 

If the symbol that you want to insert is not in the list, click More 

Symbols. In the Font box, click the font that you want, click the 

symbol that you want to insert, and then click Insert. 

Click Close. 

Change the page orientation 

 

Select the worksheet or worksheets for which you want to change 

the orientation. 

How to select worksheets 

To select Do this 

A single sheet 

Click the sheet tab.  
 
 
If you don't see the tab that you 
want, click the tab scrolling buttons 

to display the tab, and then click the tab. 
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Two or more 
adjacent sheets 

Click the tab for the first sheet. Then hold down Shift while you click the 
tab for the last sheet that you want to select. 

Two or more 
nonadjacent sheets 

Click the tab for the first sheet. Then hold down Ctrl while you click the 
tabs of the other sheets that you want to select. 

All sheets in a 
workbook 

Right-click a sheet tab, and then click Select All Sheets. 

On the Page Layout tab, in the Page Setup group, click 

Orientation, and then click Portrait or Landscape. 

Change the page orientation when you are ready to print  

Select the worksheet, worksheets, or worksheet data that you 

want to print. 

Click the File tab. 

Click Print. 

Keyboard shortcut    You can also press Ctrl+P. 

 

In the Page Orientation drop-down box, under Settings, click 

Portrait Orientation or Landscape Orientation. 

When you are ready to print, click Print. 

Create a template that uses landscape orientation by default 

To save time, you can save a workbook configured to print in 

landscape orientation as a template. You can then use this 

template to create other workbooks. 

Create the template 

 

Create a workbook. 
 

Select the worksheet or worksheets for which you want to change 

the orientation. 

How to select worksheets 

To select Do this 

A single sheet 

Click the sheet tab.  

 
 
 
If you don't see the tab that you  
want, click the tab scrolling buttons  
to display the tab, and then click  
the tab. 

 

Two or more 
adjacent sheets 

Click the tab for the first sheet.  
Then hold down Shift while you  
click the tab for the last sheet that  
you want to select. 

Two or more 
nonadjacent sheets 

Click the tab for the first sheet.  
Then hold down Ctrl while you click 
the tabs of the other sheets that  
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you want to select. 

All sheets in a 
workbook 

Right-click a sheet tab, and then  
click Select All Sheets. 

 

 

On the Page Layout tab, in the Page Setup group, click 

Orientation, and then click Landscape.  

 

Make charts 

Create a chart from start to finish 

Microsoft Excel no longer provides the chart wizard. Instead,  

you can create a basic chart by selecting any part of the range you 

want to be charted, then clicking the chart type that you want on 

the Insert tab in the Charts group. You can then continue with the 

next steps of the following step-by-step process. 

 

Learn about charts 

 

Charts are used to display series of numeric data in a graphical 

format to make it easier to understand large quantities of data 

and the relationship between different series of data. 

To create a chart in Excel, you start by entering the numeric data 

for the chart on a worksheet. Then you can plot that data into a 

chart by selecting the chart type that you want to use on the 

Insert tab, in the Charts group. 

1. Worksheet data 

2. Chart created from worksheet data 

Excel supports many types of charts to help you display data in ways 

that are meaningful to your audience. When you create a chart or 

change an existing chart, you can select from a variety of chart 

types (such as a column chart or a pie chart) and their subtypes 

(such as a stacked column chart or a pie in 3-D chart). You can also 

create a combination chart by using more than one chart type in 

your chart. 

 

Add a chart title 

 

Click anywhere in the chart to which you want to add a title. 

This displays the Chart Tools, adding the Design, Layout, and 

Format tabs. 

On the Layout tab, in the Labels group, click Chart Title. 

 

Use Multiple sheets 

Select one or multiple worksheets 

 

By clicking the tabs of worksheets (or sheets) at the bottom of the 

window, you can quickly select a different sheet. If you want to 

enter or edit data on several worksheets at the same time, you can 
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group worksheets by selecting multiple sheets. You can also format 

or print a selection of sheets at the same time. 

 

To select Do this 

A single sheet 

Click the sheet tab.  

 
If you don't see the tab that you want, click the tab scrolling buttons to display 
the tab, and then click the tab. 

 

Two or more 
adjacent sheets 

Click the tab for the first sheet. Then hold down SHIFT while you click the tab for 
the last sheet that you want to select. 

Two or more 
nonadjacent sheets 

Click the tab for the first sheet. Then hold down CTRL while you click the tabs of 
the other sheets that you want to select. 

All sheets in a 
workbook 

Right-click a sheet tab, and then click Select All Sheets on the shortcut menu. 

 

Filter in Excel 

 

AutoFilter is a quick and simple way to filter through that 

information and find what you need. Starting with inputting data, 

you will need to select and sort it and customize the auto filter. 

This 5-step process can increase your efficacy and speed. 

 

Input all your data or open the spreadsheet that contains your data. 

It is best if your data has column heading, such as categories to 

specify the data below it. If you donot have these, input them 

before you filter. 

 

Select all the data you wish to filter. Because the AutoFilter option 

is an automatic process that does not receive any specific inputs on 

how to filter, it is recommended that you choose 'all' of the data 

you have. This will avoid the possibility that you lose data 

associations across rows and/or columns. 

 

Click “Data”, then select “Filter”. 

You will immediately notice that the categories have drop-down 

buttons. Using these buttons, you can set your filter options. 

Sorting 

 

Microsoft Excel is a great tool for sorting and keeping your 

information in an organized fashion. Here is a guide for sorting your 

rows of information alphabetically. 

 

Open Microsoft Excel. 

 

Locate the column that you want to sort, and make sure the title 

of each column is in bold otherwise excel will sort it too. 

 

Click the header on the top of the Column of data you wish to sort. 

(Headers are A - B - C - D - E - etc. for columns and are Numbers for 

rows) 
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Develop a database for 30 students studying in the Class. The database must include the following data: 

Name, Father’s Name, Mother’s Name, Address, Date of Birth, Marks obtained in all Subjects in Class IX 

final examination and she told you to keep provision for 4 more data. Write the steps to create the 

database in the classroom and then create the database on the computer. 

_____________________________________________________________________________________
_____________________________________________________________________________________
_____________________________________________________________________________________
_____________________________________________________________________________________
_____________________________________________________________________________________
_____________________________________________________________________________________
_____________________________________________________________________________________
_____________________________________________________________________________________ 

 
 
 
 
Fill in the blanks 
 
1. Each square on the worksheet is called a ____________. 

2. ________________________ are prewritten formulas. 

3. The most common _________________ in MS Excel are Sum, Average, Minimum, and Maximum. 

4. ________________________ cells allow you to change the size, colour, alignment, and font type 

you want. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

In the toolbar you will find two buttons that contain the letters A + 

Z. 

 

Click the icon with A on top and Z on the bottom to sort your data 

in an Ascending format (A first, Z last). 

 

Click the icon with Z on top and A on the bottom to sort your data 

in a Descending format (Z first, A last). 

Printing 
 

Click Print 

The Print Dialog Box appears 

The Print Range should be set to All pages 

The Copies should be set to 1 

You can use the spin box to change the number of copies 

Click the OK button. 

 

Exit Excel - You can still lose your work if you do not exit 

properly. To close the Excel application: 

Click the tab, and then select Exit. 

i. If you have not saved your work, you will be asked if you want 

to save it – Click YES and save your work. 

Exercise 
 

 

Assessment  
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5. To merge a group of cells and centre the text, you can also use the _______________and 

Centre button on the Excel tool bar. 

 
 
 
Use the following checklist to see if you have met all the requirements for assessment activity: 
 
Part - A 

 

Differentiated between the following:  

 

1. Formula and function 

2. Filter and sorting 

 

Part - B 

 

Discussed in class the following: 

 

1. What are the advantages of pre-written formulae or functions in MS Excel? 

2. What are the uses of MS Excel? 

3. How often a file should be saved? 

 

Part C 

 

Performance Standards 

 

The performance standards may include, but not limited to: 

 

Performance Standards Yes No 

Demonstrated the skill of using basic functions of MS Excel   

Performed basic calculations using MS Excel   

 

 

Checklist for Assessment Activity 
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Session 4: Installation and Uninstallation of Software  
 
In this session, you will learn about the installation and uninstallation process of software on computer. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The installation process for software depends on your operating 

system and the programme that you are installing.  
 

Microsoft Windows Users 
 

General Tips 

 

Make sure your computer meets the system requirements of the 

programme, game or utility that you are going to install. 

 

The manual or the readme file contain exact instructions on how to 

install a programme and are in the same directory as the 

installation files. 

 

When installing a programme, utility, or game, it is always a good 

idea to close or disable any other programmes that is running. 

 

After installing a new programme if it prompts you to reboot the 

computer, do it. 
 

Autorun from a CD or DVD 
 

Many software programmes, games, and utilities have an AutoPlay 

feature. This feature automatically starts a setup screen for the 

software programme when inserting a CD or DVD. If your 

programme contains this feature, follow the steps that appear after 

inserting the disc. 
 

No Autorun Feature 
 

Open My Computer. 

 

Within the My Computer window, open the drive that contains the 

installation files. For example, if the files are on the CD-ROM drive 

open the D: drive or letter of your CD-ROM drive. 

 

Within the drive that contains your files, locate either 

the executable setup or install file. Double-clicking on this file 

starts the installation process. If you see multiple setup or install 

files, try to locate the Application file or double-click each of the 

setup or install files until you find the file that starts the 

installation. Many a times, the icons associated with the installation 

files have the same name. 

 

Alternate method for starting installation in Microsoft Windows 

 

Click Start and Run. 

 

In the Run Window, type x:\setup or x:\install where x is the letter 

of the install drive. 
 

Relevant Knowledge 
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Installing from a Download 
 

If the file you downloaded is an executable, click the icon twice in 

rapid succession to start the setup process. If the downloaded file 

is compressed (e.g..zip) you must extract the file's contents before 

setup can begin. Fortunately, this function is build into later 

versions of Windows. 

 

Once the files are extracted, double click the setup to install. 

 

MS-DOS Users 

 

Users installing a programme from Microsoft DOS should have a 

basic understanding of the MS-DOS commands.  

 

Before installing a programme in MS-DOS, you must switch to the 

drive or directory that contains the installation files. If you are 

installing a programme from a CD or diskette, switch to that drive. 

If the installation files are located in a different directory, use 

the dir command to list the directories and the cd command to 

switch into the appropriate directory. 

 

Once you are in the directory or drive that contains the installation 

files, run the executable for setup. Many times this can be done by 

typing setup or install at the prompt to start the installation. If 

both of these commands give a bad command or file name error 

message, type dir *.exe or dir *.com or dir *.bat. These commands 

list any executable files; if any files are listed, execute these files 

to run the installation or setup of the programme. If no files are 

listed when typing all three of the above commands, you are in the 

incorrect directory or drive letter for that programme. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Uninstallation 
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Steps of uninstallation of software in Windows 8 

 

Go to control panel from the desktop short cart and open it.  

 

Click on Programmes ‘Uninstall a programme’. 

 

‘Programmes and Features’ named window will open. 

 

Select a programme that you want to remove from your computer 

system. 

 

Above bar one tab will reflect as ‘Uninstall/Change’, beside 

‘Organize’. 

 

One window will open, if you sure then click OK. 

 

The software will remove from the system, and the computer 

should be restart. 

 

Steps of installing software in Linux Operating System: 

 

We can install software graphically or using the command line in 

the Linux OS.   

 

Software is bundled in packages which can be downloaded from 

repositories (repos).  

 

Installation tools are called package managers which automatically 

resolve dependencies on other software libraries in Linux. 

 

Following are the steps for installing software in Linux OS: 

 

Open a root shell/terminal. 

Type the root password (in Ubuntu prefix the following commands 

with sudo, in MEPIS or Aptosid, first become root by typing su). 

To update the package lists type apt-get update 

 

To search for a package type apt-cache search followed by a 

keyword such as spreadsheet. 

Type apt-get install "programme name". 

Confirm by pressing Y. You are done. 

Following are the steps for uninstalling a software from Programme 

Menu from the Linux Mint OS.  
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Install an antivirus in your computer (open source antivirus). Write down the steps you followed for its 

installation and also the problems that faced by you during the installation of the software.  

 
 
 
 
Fill in the blanks 
 
1. The installation process for software depends on your operating system and the programme that 

you are installing.  

2. Many software programmes has an _________________ feature for auto installation. 

3. A zipped file has ___________ extension. 

4. An executable file has ____________ extension. 

5. Installation tools are called ________________________managers which automatically resolve 

dependencies on other software libraries in Linux. 

 
 
 
Use the following checklist to see if you have met all the requirements for assessment activity. 
 
Part – A 
 
Differentiated between the following: 
 

1. Installation and uninstallation of a software 

2. Antivirus and antimalware 

 
 
 
 
 
Part – B 

 
 
 
 
 

 
 
 

 

Click Menu. Go to the applications you want to remove. Right click 

on the unwanted software and select Uninstall. 

Type your password and press Authenticate when asked. 

Look for the message that says, "the following packages will be 

removed." Click Remove. 

Wait for the programmes to be removed. This can take some time.  

 

Exercise 
 

 

Assessment  
 

 

Checklist for Assessment Activity 
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Discussed in class the following: 
 
Installation of anti-virus in Linux and Windows Operating System 
 
Part - C 
 
Performance Standards 
 
The performance standards may include, but not limited to: 
 

Performance Standards Yes No 

Demonstrated the procedure for installing a software   

Demonstrated the procedure for uninstalling a software   
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Introduction 
 
 

 
Meaning of Communication 

 
 
 
 

 
 
 
 
 

 
 
 
 
 
 

 
 
Communication is the ability to express and interpret thoughts, 

feelings and facts in oral and written form. It is also a means of 

interacting linguistically in an appropriate way in a range of societal, 

cultural and work context. It is the use of messages to produce 

meaning within and across a variety of contexts, cultures, methods 

and media. It is an important way through which facts, ideas, 

experiences and feelings are shared and exchanged.  

 

Primates and other animals have been communicating without the 

use of language since long before humans invented verbal 

communication. Humans communicate both verbally and non-

verbally. Verbal communication includes written and oral 

communication, whereas non-verbal communication includes body 

language, facial expression and pictures. Written communication is 

an effective tool for recording, reporting and management. The 

recording and reporting of information should be done in a 

systematic way. Our own beliefs, values and behavior interact with 

each other and it reflects in our style of communication.  

 

Communication has three important parts – transmitting, listening 

and feedback. The sender transmits the message through one 

medium or another. The receiver listens to the message and then 

conveys his understanding of the message to the sender in the form 

of feedback to complete the communication cycle. The process of 

conveying a message is complete only when the person receiving it 

has understood the message in its entirety. 

 

Communicating in an effective manner, irrespective of the mode of 

communication used is a skill. Effective communication occurs only 

if the receiver understands the exact information or idea that the 

sender intended to transmit. It involves the use of proper equipment, 

providing information to the appropriate people and carrying out 

communication effectively.  

 

Breakdown in communication is either due to lack of skills in 

communicating or lack of coherent thought process. It can also 

happen due to the breakdown of the communication network.  

 

In this Unit, you will learn about (i) greeting people and introducing 

yourself to people; (ii) frame sentences for describing people, things 

and places, (iii) describing weather, (iv) make sentences to express 

likes and dislikes, and (v) pronounce words properly.  
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Session 1: Greeting People and Giving Self Introduction 
 
In this session, you will learn how to greet people and introduce yourself to people.  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Every interaction starts with some form of greeting.  The  way we  

greet,  the tone  and  the  language  changes  according  to  our  

familiarity  with  the  person being  greeted. When you greet 

someone on phone then your tone matters a lot, but when you greet 

someone in person then your body language, smile, eye contact and 

the firm handshake matters a lot of difference. Let us now learn 

how we greet a friend, acquaintances and strangers. Some of the 

statements we generally make whenever we greet someone. 

 

Greeting a friend:  

1. Hello! How are you doing?  

2. It has been a long time since we last met!  

3. Hello! How are you doing now?  

4. How‘s life? 

 

Greeting an acquaintance:  

1. Hello! How are you?  

2. Hello! How have you been?  

3. Good morning/afternoon/evening! All‘s well? 

 

Greeting a stranger:   

1. Hello!   

2. Good morning/afternoon/evening!  

3. How do you do?  

4. My name is Aarti. May I know your name?  

 

Talking about Family 

 

A family is made up of relations and some of our relations are 

Father, Mother, Sister, Brother, Grandfather, Grandmother, Uncle, 

Aunt, and Cousin. 

 
 

Introducing One Self 

 

Introducing yourself to a stranger is an opportunity to make an 

impressive and long lasting impression. You can make a good use of 

such opportunity. Convey your name, what do you do, what are your 

hobbies, etc. Check the following commonly used  

 

1. “I would like to introduce myself. I am…” 

2. “Hi/Hello, I am...” 

3. “Hi/Hello! My name is…” 

4. “Hi/Hello! My name is…but you can call me…” 

5. “I live at…” 

6. “I am from...” 

7. “I am working as a …” 

8. “I am a …” 

Relevant Knowledge 
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Activity: Role Play  

 

Objective: This activity will be facilitated by your teacher or trainer. At the end of this activity, you will 

be able to greet friends, neighbours and strangers confidently. The following 3 situations may be used 

for a role play:  

 

Situation 1: You have met a friend after a long time. The last time you saw him was in school. How 

would you greet each other?  

 

Situation 2:  You meet your local grocer while you are taking your morning walk. You ask him if his shop 

will be open today.   

 

Situation 3: You see a person come down the stairs of your building. You have not seen him before, but 

you guess that the person may be your new neighbour.  

You greet him and introduce yourself.  

 

Practice making simple sentences using the Third Person Singular rule.  For example:  

 

 I/You take English classes.  

 S/he takes English classes. 

 

Introducing Oneself 

 

Read aloud the following sentences:  

 

1. My name is __________ (include your name). And you are?  

2. It is a pleasure to meet you.  

3. Her name is Nisha. And the two men she is talking to is Manoj and Rahul.  

4. He is an Auto mechanic. He works at XYZ workshop.  

 

Read this:  
 
1. I have a dog.   
2. Do you have a dog?  
3. We have a dog.  
4. He has a dog. 
 
Making Sentences: Talking About Family 
 
Make simple sentences using the third person singular rule.  For example:  
 
1. I have a brother and a sister.  
2. My parents work at the same office.  
3. My grandmother and grandfather live with us.  
4. My Aunt teaches at a school. 

 

9. “I studied at…” 

10. “I am/came here to…” 

11. “My hobbies are…” 

12. “I like…” 

Exercise 
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A. Fill in the blanks with the correct option.  
 
1. Hi! I ___ Priya. 

(a) is     (b) am              (c) are  

2. _____ am 21 years old.   

(a)  He (b) I (c) She   

3.  I _______ in Delhi.   

(a) live (b) lives      

4.  There _______ six members in my family.   

(a) is  (b) are (c) was  

5.  My parents ________ me very much.  

(a) loves (b) love  

6.  My brothers _______ working.   

(a) is (b) am  (c) are   

7.  My father ______ a farmer.   

(a) is (b) am (c) are   

8.  My mother _________ a housewife.  

(a) are (b) is (c) am  

9.  I ___________ one sister.  

(a) has (b) have (c) having  

10. She __________ a student.   

(a) is (b) am (c) are 

 

B. Fill in the blanks with the correct option.  

1. Hello, Sir! How ______ you?  

(a) is                       (b) are                       (c) am  

2. One of the best ways to greet a stranger _______ a simple “Hello!” 

(a) is                       (b) are                       (c) has  

3. Both Meena and Reena _______ people nicely.  

(a) greets                (b) greet                    (c) greeting  

4. One of those girls who ______ at the office said “Hi” to me. 

(a) works                (b) work                     (c) working  

5. If it is morning, you can _______ “Good morning” as a form of greeting. 

(a) says                  (b) say                        (c) saying  

6. One of my favourite ways of greeting people ______ “What‘s up?” 

(a) is                      (b) are                        (c) being  

 

7. The Japanese way of saying goodbye _______ “Sayonara”. 

Assessment 
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(a) is                      (b) are                        (c) being  

8. Bon jour ____ what the French _______ to greet someone. 

(a) is, says              (b) are, say                  (c) is, say  

9. No form of greeting ____ as popular as ―Hello! 

(a) is                      (b) are                         (c) has                    

10. Neither Preety nor Kirti ______ Ritu when they meet her.    

(a) wishes               (b) wish                       (c) wishing  

 
B. Tick the correct sentence  
 

1. I wish my neighbour every morning.   

2. He wish me back.  

3. I ask him how he is doing.   

4. He say that he is doing well.   

5. Then we goes to the Mother Dairy booth to buy milk.  

6. We talk about the day‘s news.  

7. We walk back and says―bye‖ to each other. 
 

 
C.  Making Sentences:  
 
(i) Talking About Family 
 
Fill in the blanks with the correct option:  
 

1.  Saumya _____ a Punjabi.  

a. is  

b. are  

2.  She _____ in Ambala.  

a. lives  

b. live  

3. Her father and her mother __________teachers.  

a. is  

b. are  

4.  Her grandmother _________ with them.  

a. live  

b. lives  

5.  Her sister __________ to college  

a. go  

b. goes  

6.  Her brother __________ a carpenter.  

a. am  

b. is  

7.  He ___________ in Delhi.  

a. work  

b. works  

8.  Saumya ____________ to join the Army.  

a. wants  
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b. want  

9.  Her father ________ in the army for 3 years.   

a. are  

b. was  

10. Saumya ____ to her brother every week.  

a) speak  

b) speaks 

 
 

 
 
 
Use the following checklist to see if you have met all the requirements for assessment activity. 
 
Part – A 
 
Differentiated between the following: 

 

Greeting a friend and greeting a stranger 

 

Part – B 

 

Discussed in class the following: 

 

1. How to introduce yourself in different situations? 

2. How to greet people? 

3. Different ways to describe one’s family? 

 

Part - C 

 

Performance Standards 

 

The performance standards may include, but not limited to: 

 

Performance Standards Yes No 

Demonstrated the skill of introducing self   

Demonstrated the skill of greeting strangers and friends   

Framed sentences to describe family members   

 

Checklist for Assessment Activity 
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Session 2: Framing Sentences  
 

In this session, you will learn how to frame sentences to describe different situations. At the end of this 
session you will also learn how to describe things. 

 

 
 
 
 
 
 
 
 
 

 
 
Making Sentences 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Look at the following sentences:  

 

I greet you every day. You greet me every day. He greets me every 

day.  

 

We greet you good morning. You all greet us good morning. They 

greet us good morning.  

 

Do you see any change in the two sets of sentences? 

 

There is a rule which is the reason behind the change: 

 

For any subject (name of a person, place or thing) that is in the 

third person and singular (Ram, Rita, he, she, it, Delhi, bus, chair, 

etc.), the verb will take an “s” or “es” after it. 

 

When making sentences follow some simple rules. For example, 

write short sentences and paragraphs, capitalize the first letter of 

each sentence, be clean in your message, write to the point, be 

concise in communicating your message and provide a complete 

response. 

 

Examples of Sentences 

1. Ram meets new people every day.  

2. He works as a sales person.  

3. Delhi gets rain in the month of July and August.  

4. The bus goes to Munirka.  

5. The chair makes a noise when you sit on it.  

 

For every other subject – first and second person, singular or plural, 

and third person plural (Ram and Rita, they, Delhi and Bombay, 

buses, chairs, etc.) – the rule will not apply. 

I meet new people every day.  

1. We meet new people every day.  

2. You meet new people every day.  

3. You all meet new people every day.  

4. Ram and Rita meet new people every day. 

 

While framingquestions, the sentences may begin with   questions;  

 

Examples:  

 

Which student was absent yesterday?  

Is he present today?  

Did he bring his leave report today?  

Read aloud the following sentences:  

 

Relevant Knowledge 
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1. I am Mina.  

2. My name is Mina.  

3. I am from Delhi.  

4. I am here to meet a friend.  

5. I came by bus.   

6. Yes, I am an Indian.  

7. No, I will not shop with my friend.  

8. Yes, I have called her up.  

 

Study the list of ‘Question Words’ given below: 

Word Example 

What  1. What are you doing tonight?  
2. What are we having for dinner? 

When 1. When is the match starting?  
2. When are we leaving? 

Where 1. Where is my diary?  
2. Where will the World Cup be held this 

year? 

Which 1. Which one is your book?  
2. Which colour should we buy? 

Who 1. Who is that girl?  
2. Who stole the cell-phone? 

Whom 1. With whom did you go to see the movie?  
2. Whom did you meet at the party? 

Whose 1. Whose towel is this?  
2. Whose dog is barking this late at night? 

Why 1. Why didn‘t you do your homework? 
2. Why are we visiting her? 

How 1. How are we going to tell him about the 
situation?  

2. How is the book that you are reading? 

Are 1. Are you Akanksha‘s sister? 
2. Are you going to see him again? 

Is 1. Is she doing her homework?  
2. Is Manisha ill? 

Am 1. Am I really going to take that chance?  
2. Am I happy? 

Have 1. Have you seen the new movie?  
2. Have I done the right thing? 

Has 1. Has she completed her shift?  
2. Has it started boiling? 

Do 1. Do we need to confirm the time and 
place?  

2. Do you have to go to the bank today? 

Does 1. Does he ever knock before entering a 
room?  

2. Does the cat often steal from your 
kitchen? 

Can/Could 1. Can I go to the mall?  
2. Could you give me that magazine? 
3. Can you play chess? 

Will/Would 1. Will you be there on my wedding?  
2. Will my book be published?  
3. Would you sing if they ask you to? 

Shall/Should 1. Shall we go now?  
2. Shall I do the job for you?  
3. Should you leave early to reach on time? 
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Describing People, Places and 
Things 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

May 1. May I come in?  
2. May I go out for a moment? 

 
Read the following sentences:  

 

1. Oh I am late already…what is the time?  

2. Excuse me…can you please tell me the time?  

3. Hey! What time does the movie start?  

4. When do we have to meet Mr D‘Souza?  

5. What time is the appointment?  

6. When is he going to come?  

 

Questions usually start with words like what, when, how, where, 

why, is, can, do, did, will, would, could, etc. and that they are 

always placed at the beginning of the sentence. So we cannot say: 

 

1. The time is like what?  

2. You can please tell me the time?  

3. The movie starts what time?  

4. The appointment is what time?  

5. He is going to come when?  

 

If the question pertains to asking for time, they will  typically  begin  

with:  

When… or What time… or Can you tell me… 

 

Read this:  

 

If the question pertains to asking for time, they will typically 

begin with: When or What time… or Can you tell me…Example:   

1. What time is it?        √ 

2. Where is the time?    X 

 

Read aloud the following sentences:  

 

1. Dev Kumar is my favourite film star.  

2. He is tall, dark, and handsome.  

3. The clothes he wears are so fashionable.  

4. His style of dressing very soon sets a trend that all follow.  

5. I loved his latest movie KabTak.  

6. In the movie, he plays the role of a thief superbly.  

7. He wears dark clothes when he goes to burgle people‘s homes 

at night. 

8. He is almost never caught. He manages to escape everytime.  

9. Once, hearing some noise, the owner of the house switches on 

the lights.  

10. Dev  Kumar  quickly  puts  on  his  ghost mask  and  the  owner  

gets  so  scared that he jumps off the balcony!  

11. Then Dev Kumar silently leaves the place but not without his 

booty.  
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Framing Complete Sentences 

 

An adjective describes a noun – a person, thing or place.  

 

Example: Delhi is very hot in summer. (describing noun summer)  

An adverb describes an adjective, a verb, or another adverb.  

 

Example: Delhi is very hot in summer. (describing adjective hot)  

The temperature quickly rises to over 40°C. (describing verb rises).  

 

It almost never comes below 40°C in the month of June. (describing 

the adverb never)  

 

Adjectives describe a noun/pronoun:  

 

1. This tea is sweet.  
2. I am angry right now.  
 

In the above sentences, the words “sweet” and “angry” describe 

the noun “tea” and the pronoun “I” respectively. Therefore, the 

words “sweet” and “angry” are adjectives. More examples are 

given below: 

 

1. It looks like we have a clear sky today.  
2. She looks happy, doesn‘t she? 
 

Adverbs describe adjectives, verbs, or other adverbs.  

1. This tea is very sweet.  
2. She gets angry quickly.  
3. He was smiling rather sadly.   
 

In the first example, the adverb “very” describes the adjective 

“sweet”. 

 

In the second example, the adverb “quickly” describes the verb 

“gets”. 

In the third example, the adverb “rather” describes the adverb 

“sadly”. 

 

More examples are given below:  

1. She is so excited about the party.  
2. We arranged the place nicely.  
3. Spring gets over too soon.\ 
 
A complete sentence should have a subject and a verb; otherwise, 
it is just a fragment of a sentence.  
 
 
Read the following sentences:  
 
 Is a cold day. (“Is a cold day” does not have the subject “It”). 

The complete sentence would be “It is a cold day”. 
 The sky clear.  (“The sky clear” does not have the verb “is”). 

The complete sentence would be “The sky is clear”. 
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You  can  also mention  that  typically,  a  sentence  in  English  has  
the  order  SVO (Subject  –  Verb  –  Object).  For example:  The rain 
(subject) brought (verb) welcome relief from the heat (object). 
 
A  complete  sentence  is  one  that  has  a  subject  and  a  verb.  
For example, the sentence ―I a good dancer‖  is not a complete 
sentence as it does not have a verb. Now, if we added the verb 
―am‖  to this sentence, it would be complete: I am a good dancer.  
 
Similarly, the sentence “Am a good dancer” is not complete as a 
subject is missing.  Therefore, we should add a subject to complete 
the fragment.  For  
Example: I am a good dancer.  
 
Examples:  
We have an English class today.  

I go to office every weekday.  

She likes oranges.  

 

Every sentence must have a subject, a verb and although it is not 

necessary, an object. And the sentence must make complete 

sense.  

 

For example,  

 

1. I eat: Subject+Verb 

2. I eat vegetables:  Subject+Verb+Object 

 

In order for a sentence to be meaningful, a sentence must have its 

parts in the above orders. For example:  

 

1. I eat vegetables – is a sentence  

2. I vegetables eat – is not a sentence  

3. I like dancing.  

4. I am here.  

5. You go to school.  

6. She has a nice smile. 

 

Understand the meaning of words like “favourite”, “pastime”, 

“hobby”, “passion”, “passionate” and “fond” with the help of the 

following table. 

 

Word Meaning 

Favourite most liked 

Pastime a pleasurable means of passing the 
time 

Hobby an activity for enjoyment 

Passion a strong liking for something.  An 
object of strong liking and 
enthusiasm 

Passionate having a strong liking for 

Fond having a strong liking for 
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A. Frame a question for the following situations:   

 

1. You want to ask a person his/her name.  

2. You want to ask a person where he/she lives.  

3. You want to ask what he/she is doing presently.  

4. You want to ask why he/she is here.  

5. You want to ask how he/she goes to office.  

6. You want to ask when he/she is going back.  

 

B. Identify the errors and correct the questions given below:  

 

1. Can you do the work for me?  

2. When do you want this book?  

3. I can find the class where?  

4. You will meet me at the station?  

5. You can get the file?  

6. Why are you so sad?  

7. You are why so happy?  

8. Do you work at the mall?  

9. Where do you live?   

10. What is the price of the book?  

11. You do want some help?  

12. Did you see the movie?  

13. When did the movie start?  

14. You will do me a favour? 

 

Make simple questions using what you have learned and practiced.  For example:  

 

1. When do I have to come?  

2. What time does the class start?  

3. Can you tell me the reporting time for the flight? 

 
 
 
 
A. Tick the correct option:  
 
1. It is the name of a person.  

a) Is it the name of a person?   
b) The name of a person is it?  

  
2. The person is male.  

a) Is the person male?  
b) The person is male?  

 
3. He is Indian.  

a) Is he Indian?  
b) He is Indian?  

  

Exercise 

Assessment  
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4. He is an actor.  
a) An actor he is?  
b) Is he an actor?  

 
5. He is married.  

a) Is he married?  
b) Married he is?  

 
6. He has two children.  

a) How many children does he have?  
b) How many he has children?  

 
7. He has a son and a daughter.  

a)  How many sons and daughters does he have?  
b)  Sons and daughters how many he has?  

 
8. He lives in Mumbai.  

a) Where does he live?  
b) In Mumbai he lives? 

 
9. He was brought up in Delhi.  

a) He was brought up in Delhi?  
b) Where was he brought up?  

 
B. Tick the correct option.   
 
1.   

a. Is we on time?  
b. Are we on time?  

2.   
a. When is the time by your watch?  
b. What is the time by your watch?  

3.   
a. When does the train leave?  
b. What does the train leave?  

4.   
a. At what time is the meeting?  
b. At when time is the meeting?  

5.   
a. On time are we?  
b. Are we on time?  

6.   
a. Could you tell me the time please?  
b. You could please tell me the time?  

7.   
b. When wake up do you?  
c. When do you wake up?  

8.   
a. Are you come on time?  
b. Will you come on time?  

9.   
a. Is your flight on time?  
b. Your flight is on time?  

 
10.   

a. When are you planning to leave for Bangalore?  
b. Are you when planning to leave for Bangalore? 
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C. Read the passage and identify whether the words in bold is adjective or adverb  
 
There is this girl called Helen in our class. If you want to know how she looks, then here are the details:  

she is quite tall, she has dark skin, and her hair is long and shiny. Oh! She also has dimples (which we 

don’t get to see often as she doesn‘t smile much!).  

 

She doesn’t talk much or take an active part in any group programs. No wonder why she stays alone most 

of the time. But she looks very nice when she smiles.  

 

As I have already said, she has dimples which we don’t see often (as she doesn’t smile much). I think it 

was the smile that made me strong enough to talk to her one day. 

 

“Hey Helen!” I said to her (I was really afraid she might not want to talk to me).  

“Hi!” said Helen. 

“Would you like to have lunch with me?” 

“That’s nice of you. But I do not eat meat. I hope you haven’t brought meat?” 

“Uh…yes...sorry!” 

 

So, now I have one more thing to tell you about Helen. She is a vegetarian. 

 
D. Write whether the words give below (as used in the passage) are adjectives or adverbs:   
 
1. Quite___________________  

2. Tall____________________  

3. Dark ___________________  

4. Long ___________________  

5. Shiny ___________________  

6. Much____________________  

7. Active___________________  

8. Alone ___________________  

9. Very_____________________  

10. Nice ____________________  

11. Strong ___________________  

12. Enough __________________  

13. Really ___________________  

14. Afraid____________________ 

 

 
 
 
Use the following checklist to see if you have met all the requirements for assessment activity: 
 
Part – A 
 
Differentiated between the following: 
 
Adjective and adverb 
 
 

Checklist for Assessment Activity 
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Part – B 
 
Discussed in class the following: 
 
1. How to describe a person, place or a thing? 
2. How to make interrogative sentences? 
 
 
Part - C 
 
Performance Standards 
 
The performance standards may include, but not limited to: 
 

Performance standards Yes No 

Framed sentences to express time   

Framed sentences to describe a place, thing and people   

Framed sentences to give good wishes   

Framed sentences to invite people on different occasions    
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Session 3: Describing Weather and Expressing Likes and Dislikes 
 

In this session, you will learn how to describe the weather and express likes and dislikes using simple 
sentences. 

 
 

 

Describing Weather 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Expressing Likes and Dislikes 

 

Read and understand the following sentences:  

1. It is very hot today.  

2. It is very cold today.  

3. It is raining today.  

4. Today the weather is pleasant – it is neither too hot nor too 

cold.  

Read aloud the weather and climate descriptions given below: 

Day’s Weather City’s Climate 

It is quite cold today. It is very hot in summers. 

It is very chilly today It is very cold in winters. 

It is so hot today It gets very less rainfall. 

It is quite warm today. It gets a lot of rain in the 

monsoon season. 

It seems it is going to rain. It is neither too hot nor too 

cold. 

What a downpour! It is very cold in winters but 

pleasant in summers. 

Haven‘t seen such rains for 

quite some time. 

It is very hot in summers but 

cool in winters. 

We are going to have a shower. It rains almost throughout the 

year. 

It is very pleasant today. It is very hot during the day 

but cooler at nights. 

It is neither too cold nor too 

hot. 

It is hot and dry in summer. 

Lovely day, isn’t it?  

Looks like it isn’t going to stop 

raining today! 

 

I think the skies are going to 

clear up later. 

 

 

Read the conversation given below:  

 

A: Hi! How are you doing?  

B: I am fine…what’s up? 

A: Nothing new.  I was just  going  across  to  the  shop  to  get  a 

magazine.  I am going to stay indoors and read all day today.   

B: Yeah…I know. It is too hot to go out to play. 

A: But you know, I think it is going to rain later in the day…do you 

see the dark clouds?  

B: That would indeed be a welcome relief.   

A: Yes, a cool shower would be great!  

B: As it is so hot, why don’t we go for a swim today? 

A: Mom…it may rain in the evening…how about a dance in the rain 

instead? 

 

 

Relevant Knowledge 
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A. Correct these simple sentences using what you have learnt.   

1. It was freezing cold yesterday.  

2. Going to rain very soon.  

3. It is so hot and humid.  

4. The rain has only increased the humidity.  

5. A nice breeze blowing.  

6. Lovely weather this. 

 

B. Tick the sentences that are meaningful and correct:  

 

1. I very happy.  

2. She is very happy.   

3. He goes to school. 

4. He does not go to school.  

5. I oranges like.   

6. Oranges I like  

7. She and Meeta to theatre.   

8. Meeta is going to the theatre.  

9. You do your homework well.  

10. Do your homework well.  

11. I dancing like.   

12. I here am.   

13. You go school to.   

14. She has a smile nice. 

 

C. Find out the meanings of the words and write in the space given below:   

 

1. Unique __________________ 

2. Pet ______________________  

3. Preferred____________________  

 

Read aloud the following sentences:  

1. Premchand is my favourite writer.  

2. His novel, Gaban, is my favourite book.  

3. I like the ghazals of Ustaad Amir Ali. The ghazal he sang in the 

movie Leela is my favourite.  

4. The bookstore near my house is my favourite haunt. I always 

go there when I have the time to spare. Browsing through books 

is my favourite pastime.  

5. Pizza is an all-time favourite snack. I can have it anytime, 

anywhere.  

6. Tea is my favourite beverage.  There is nothing like a hot cup 

of tea in winters and iced tea with lime in summers.  

7. White is my favourite colour. Whenever I shop for clothes, I 

invariably select ones that are white. 

Exercise 
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4. Choice ___________________________  

5. Favoured_________________________ 

 

 

  
A. Tick the option which is a complete sentence.  

1.  

(a) Today a fine day.  

(b) Today is a fine day.  

(c) A fine day.   

2.  

(a) It is bright and sunny.  

(b) It bright and sunny.  

(c) It bright sunny  

3.  
(a) It rained yesterday.  
(b) It raining yesterday.  
(c) Yesterday it raining. 

4.  
(a) It was very cold.   
(b) It very cold.  
(c) It cold  

5.  
(a) It is not cold today.  
(b) It not cold today.  
(c) It cold not today  

6.  
(a) We on a picnic today.  
(b) We could go on a picnic today.  
(c) Could go on a picnic today.  

7.  
(a) The sky seems clear and bright.  
(b) The sky clear and bright.  
(c) The seems clear and bright 

8.  
(a) Thank God it is not raining.  
(b) Thank God it not raining. 
(c) Thank it raining not  

9.  
(a) Should we umbrellas just in case it rains?  
(b) Should take umbrellas just in case it rains?  
(c) Should we take umbrellas just in case it rains?  

10.      
(a) It will not rain today.  
(b) It not will rain today.  
(c) It not rain today  

11.        
(a) I am person hardworking.  
(b) I am a hardworking person.  
(c) I hardworking. 

12.      
(a) I am not lazy.  
(b) I lazy am not.  
(c) I not am lazy.  

13.        
(a) I work team in well.  
(b) I work well in a team.  
(c) I team work well.  

Assessment 
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14.   
(a) I have good skills communication.  
(b) I good communication skills.  
(c) I have good communication skills.  

15.        
(a) I don‘t give up easily. 
(b) I don‘t give easily up. 
(c) I give up easily don‘t. 

16.       
(a) I get angry quickly.  
(b) I quickly angry get.  
(c) I angry get quickly 

 
 
 
 
Use the following checklist to see if you have met all the requirements for assessment activity. 
 
Part – A 
 
Differentiated between the following: 
 
1. Weather and climate 
2. Like and dislike 
 
Part – B 
 
Discussed in class the following: 

 
Making sentences to express about weather, people, places and things. 
 
Part – C 
 
Performance Standards 
 
The performance standards may include, but not limited to: 
 

Performance Standards Yes No 

Framed sentences to express weather, people, places and things   

Framed sentences for expressing likes and dislikes    

 
 
 
 
  

Checklist for Assessment Activity 
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SESSION 4: PRONOUNCING WORDS  
 

In this session, you will study about the areas, relations, subfield, transcription and application of 
phonetics or phonology. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Every speaker has individual features in the acoustic signal of 

his/her voice (consonantal sounds, vocalic sounds, pitch, 

intonation, accent/dialect, social background, age, mood, etc.). 

Phonetics is a branch of linguistics that comprises the study of the 

sounds of human speech, or in the case of sign languages, the 

equivalent aspects of sign. It is concerned with the physical 

properties of speech sounds or signs (phones), their physiological 

production, acoustic properties, auditory perception, and neuro-

physiological status.  

 

Phonology, on the other hand, is concerned with the abstract, 

grammatical characterization of systems of sounds or signs. While 

it is widely agreed that phonology is grounded in phonetics, 

phonology is a distinct branch of linguistics, concerned with sounds 

and gestures as abstract units (e.g., distinctive features, 

phonemes, Mora, syllables, etc.) and their conditioned variation 

(via, e.g., allophonic rules, constraints, or derivational rules). 

Phonology relates to phonetics via the set of distinctive features, 

which map the abstract representations of speech units to 

articulator gestures, acoustic signals, and/or perceptual 

representations. 

 

Sub-fields of Phonetics 

 

The field of phonetics is a multi-layered subject of linguistics that 

focuses on speech. In the case of oral languages there are three 

basic areas of study: 

 

(i) Articulator phonetics: The study of the production of speech 

sounds by the articulator and vocal tract by the speaker. It is 

concerned with the articulation of speech: the position, shape, and 

movement of articulators or speech organs, such as the lips, 

tongue, and vocal folds. 

 

(ii) Acoustic phonetics:  The study of the physical transmission of 

speech sounds from the speaker to the listener. The spectro-

temporal properties of the sound waves produced by speech, such 

as their frequency, amplitude, and harmonic structure. 

 

(iii) Auditory phonetics: The study of the reception and perception 

of speech sounds by the listener. These areas are inter-connected 

through the common mechanism of sound, such as wavelength 

(pitch), amplitude, and harmonics. It deals with the perception, 

categorization, and recognition of speech sounds and the role of 

the auditory system and the brain in the same. 

 

 

 

Relevant Knowledge 
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Transcription 

 

Phonetic transcription is a system for transcribing sounds that occur 

in a language, whether oral or sign. The most widely known system 

of phonetic transcription, the International Phonetic Alphabet 

(IPA), provides a standardized set of symbols for oral phones. The 

standardized nature of the IPA enables its users to transcribe 

accurately and consistently the phones of different languages, 

dialects, and idiolects. The IPA is a useful tool not only for the study 

of phonetics, but also for language teaching, professional acting, 

and speech pathology. 

 

Applications of Phonetics 

 

Applications of phonetics include the following: 

 

Forensic phonetics: the use of phonetics (the science of speech) 

for forensic (legal) purposes, such as in hoax calls, sexual 

harassment calls, telephone calls from kidnappers, etc. 

 

Speech Recognition: It is the translation of spoken words into text 

by a computer system. It analyses the person’s specific voice and 

use it to fine tune the recognition of person’s speech, resulting into 

more accurate transcription. Applications of speech recognition 

include (i) voice user interfaces, such as voice dialing, (ii) call 

routing, (iii) internet search, (iv) simple data entry and (v) speech 

to text processing.  

 

Homonyms and Homophones 

Homonyms are words that are both spelled and pronounced the 

same, but have different meanings. However, some authors use the 

term more broadly, to refer to homographs (spelled the same) 

or homophones (pronounced the same). 

 

Examples of Homonyms 

1. Air-Heir 

2. Aisle-Isle 

3. bare-Bear 

4. Be-Bee 

5. Beat-Beet 

6. Buy-By 

7. Cent-Scent 

8. Die-Dye 

9. Meat-Meet 

10. Right-Write 

 

Examples of Homophones 

1. Their-There 

2. Dam-Damn 

3. Dear-Deer 

4. Desert-Dessert 

 

https://en.wikipedia.org/wiki/Homonyms
https://en.wikipedia.org/wiki/Homograph
https://en.wikipedia.org/wiki/Homophone
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Like any other language, English has its own unique set of sounds. If you want to speak English well, you 

should pronounce English words correctly. Practice English pronunciation using dictionary and recordings. 

 
 
 

 
Practice the pronunciation of the following words: 

 

Short A Long A Open A An/m 

At Name All And 

Have Say Want Can 

Had Same Also Am 

Has Play Small Land 

Add Way Water Animal 

Act Make Call Stand 

Ask Day Saw Answer 

Than Change Walk Man 

After Page Always Plant 

Back May Fall Plan 

Last Take Watch Family 

Example Place Talk Am 

 
 
 
 

I. Short Answer Questions 
 
1. State two applications of phonetics? 
______________________________________________________________________________
________________________________________________________________________ 
___________________________________________________________________________ 
2. What do you mean by acoustic phonetics? 

______________________________________________________________________________
________________________________________________________________________ 
___________________________________________________________________________ 

___________________________________________________________________________ 
___________________________________________________________________________ 
 

 
 

II. Fill in the blanks 

1. Every speaker has individual features in the _________________ signal of his/her voice 

2. ____________________ is a branch of linguistics that comprises the study of the sounds of human 

speech 

3. ______________________________ is concerned with the abstract, grammatical characterization of 

systems of sounds or signs 

4. _______________________ phonetics is the study of the production of speech sounds by the 

articulator and vocal tract by the speaker 

5. ____________________ phonetics is the study of the physical transmission of speech sounds from 

the speaker to the listener 

6. _______________________phonetics is the study of the reception and perception of speech sounds 

by the listener. 

Exercise 

Assessment 
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7. _________________________ transcription is a system for transcribing sounds that occur in a 

language, whether oral or sign. 

8. Bare-Bear is an example of ________________. 
 

 
 

 
 

 

Use the following checklist to see if you have met all the requirements for assessment activity: 

 

Part – A 

 

Differentiated between the following: 

 

1. Phonetics and phonology 

2. Homonyms and homophones 

 

Part – B 

 

Discussed in class the following: 

 

1. What is the relation between phonetics and phonology? 

2. How to learn pronunciation of words?  

 

Part - C 

 

Performance Standards 

 

The performance standards may include but not limited to: 

 

Performance standards Yes No 

Demonstrated the skill of using pronunciation symbols found in the dictionary   

Differentiated between the weak and strong form of pronunciation of common words   

 

 

 
 
 
 
 
 
 
 
 

 

Checklist for Assessment Activity 
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Introduction 
  

 

 

Customer service is the activity of identifying and satisfying 

customer needs. When a customer visits a retailer to buy something 

s/he expects that s/he should be welcomed properly and get all the 

information related to product, services and after sale services, such 

as; technical details or properties of the product, repayment terms, 

delivery, etc.  

 

Customers expect that they should get some extra benefit in some 

cases from the additional service. At the same time hope that they 

will get a better treatment in availing after sales 'service' from the 

retailer.  

Customer service is the "sum of acts and elements that allow 

consumers to receive what they need or desire from the retail 

establishment."  

People look for positive attitude from the salesperson, which include 

respect, knowledgeable advice on products and a fair price.  

When a customer enters the store, it is important that the retailer 

or the person handling the customer does everything to make the 

customer feel important and make sure that he/she leaves the store 

with utmost satisfaction. It requires that the customer should be 

properly greeted, made comfortable and handled properly through 

proper communication, gestures and body language.   

Active listening, questioning and clarification are some of the 

important skills to learn in order to identify the needs of the 

customer and to ensure that she/he has understood the product or 

the services that she/he is looking for.  

Making people feel special is one of the essential elements in 

establishing good relationships with customer. According to David 

Jenkin, author of the book on “What Great Retailers Do”, retailing is 

both a science and art.  

Great retailers realize that it is essential to operate with strict 

discipline and have in place strong financial procedures while at the 

same time always being ready to quickly adapt business practices to 

customers’ needs to a great new idea or to competitive influences.  

In this Unit, you will learn about the essentials of dealing with 

customers and handling their queries and complaints.   
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Session 1:  Handling Customers Effectively 

In this session, you will learn how to deal with customers pleasantly and effectively. 

 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

A customer is the recipient of a goods or service, or a product, or 

an idea, obtained from a seller, vendor, or supplier via a financial 

transaction or exchange for money or some other 

valuable consideration. 

Talking to a customer requires good communication skills. When 

you meet a customer, you always need to start by saying “hello” 

and “nice to meet you”. Say “thank you” for expressing your 

gratitude and “goodbye” when the customer leaves the store, 

even if has not bought anything.  

 

It is really important because the customer who is leaving your 

store today without buying your product or service may come back 

someday or reach out to tell others about it because of your good 

behaviour. Always speak in a language that your customer can 

easily understand and appreciate. 

 

 

 

 
 

 
 
 
 

  
 
 
 
 
 
 

 

 

 

 

 

Answering customer’s telephone calls 

 

The way you answer your telephone creates an immediate 

impression, especially if it is your first contact with the caller. 

When answering the phone in the workplace, identify yourself to 

let callers know who they reached, establish a friendly tone for the 

conversation, and be responsive in general. Table 1 summarizes the 

do’s and don’ts that the salesperson should follow while speaking 

to a customer.  

 

Do’s and don’ts while Speaking to a Customer 

 

Element Do’s Don’ts 

Answering Answer promptly, such 

as within three rings, if 

you are answering a 

telephone call 

Don’t 

risk missing an 

important call 

Greeting Start with a standard 

greeting such as “Hello,” 

“Good morning,” or 

“Good afternoon” 

Don’t use expressions 

such as “Yes?”, “Uh-

huh,” or your last 

name 

Talking and 

Listening 

Focus on the caller. 

If you receive a call at 

inconvenient time, offer 

to call back later 

Don’t check your mail 

or do something else 

that will distract you 

from call 

Don’t answer the phone 

with anything in your 

mouth 

 

Relevant Knowledge 
 

https://en.wikipedia.org/wiki/Good_(economics)
https://en.wikipedia.org/wiki/Service_(economics)
https://en.wikipedia.org/wiki/Product_(business)
https://en.wikipedia.org/wiki/Seller
https://en.wikipedia.org/wiki/Vendor
https://en.wikipedia.org/wiki/Distribution_(business)
https://en.wikipedia.org/wiki/Exchange_(economics)
https://en.wikipedia.org/wiki/Money
https://en.wikipedia.org/wiki/Consideration
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1. Introduce yourself 

 

Introduce yourself with your first and last name and the name of 

your organisation or department. If most of your calls come from 

people outside of your company, start with the name of the 

organization. For example, “Thank you for calling ABC. This is 

Manisha. How can I help you?” If most of your calls come from within 

the organization, use the name of your department: “This is Rita 

from Enquiry Department.”  

 

2. Focus on your caller 

 

It is discouraging and unproductive to have a conversation with 

someone who is checking e-mail, reading the newspaper, or is 

otherwise distracted. When you speak on the phone, focus your 

attention on the caller. Turn away from your work and computer 

when listening and talking. Doing this helps you sound respectful 

and responsive to your caller. 

 

3. Be prepared to talk 

 

Do not chew gum, eat, or drink when talking on the telephone. 

Because the microphones in handsets and cell phones are sensitive, 

your caller will clearly hear the sounds that you are making. 

Remove any chewing gum or swallow food that you are eating 

before answering a telephone call.  

 

4. Don’t let the telephone interrupt you 

 

If someone calls at an inconvenient time, let them know and offer 

to call back later. If you are especially busy or having an important 

meeting with someone, mute your ringer and let the call transfer 

to voice mail. Be sure to check these messages when your schedule 

permits.  

 

Telephone Etiquette 

 

The following etiquette should be followed while talking on 

telephone: 

 

 Pick up or answer the telephone before the third ring. 

 Some words that you should use in your conversations on 

telephone are “Hello! Good Morning/Good Afternoon/Good 

Evening”. Speak clearly and identify yourself. 

 If the caller does not introduce himself/herself, say, “May I 

know who is speaking?” 

 In case the caller does not tell to whom he/she wants to talk 

to, then you may ask questions like “May I know to whom you 

want to talk to?” 

 In case you have to take a message then you may say “I'm 

sorry, he's busy at the moment. May I take a message?” or 

May I take your name and number and have him/her call you 
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Visit a mobile store and study the ways and means adopted by the sales person in convincing the customers 

about the utility, price and quality of the mobiles. Prepare a 2-page note based on your observations and 

include the same in your portfolio.  
 

 
 
 
 
 
 
 
 

 
 
Short Answer Questions 
 
 

List at least 06 points that you will consider while talking to a customer about the product features of a 
healthcare equipment to a customer. 
 
1. 
 
2. 
 
3. 
 
4. 
 
5. 
 
6. 
 
 
 
 
 
 
 
 
 
 

back? (Be sure to write down the name, phone number, time 

the caller had called and the message). 

 Ask the caller to wait while you acquire the information 

required. 

 Don’t make the caller wait for more than 02 minutes. It is 

better to return a call than to keep someone on hold too long. 

Do not forget to return the call. 

 At the end of the waiting period, please express your gratitude 

for caller’s patience. 

 Keep your conversation to the point. 

 End the conversation with gratitude. 

 Always use a pleasant and friendly tone.  

 Before placing a caller on hold, ask his/her permission first. 

For example, “could you please hold the line, while I call 

the person”. 

 Avoid leaving long messages. 

 Do not interrupt the person while he/she is talking to you. 

 Do not answer the phone if you are eating. You should mention 

that you are having your meal and you will call back after you 

have finished. 

 

 

 
Exercise 

 

Assessment  
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Use the following checklist to see if you have met all the requirements for assessment activity: 
 

Part – A 

 

Differentiated between the following:  
 

1. Goods and products 

2. Goods and services 

3. Tangible and intangible 

4. Customer and consumer 

 

Part – B 
 

Discussed in class the following: 
 

1. How to talk to a customer on phone? 

2. Do’s and don’ts while speaking to customers on phone. 

 

Part - B 
 

Performance Standards 
 

The performance standards may include, but not limited to: 
 

Performance standards Yes No 

Followed do’s and don’ts while demonstrating the skill of talking to a customer on 

phone 

  

 

Checklist for Assessment Activity 
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Session 2: Taking Orders on Call 
 

In this session, you will be able to learn the ideal way of interacting with callers when taking orders 
over the telephone. 

 
 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
Telemarketing is an act of selling goods and services to potential 

customers over telephone. A telemarketer is a person who is 

responsible for selling a product or service over the phone. 

Telemarketers may work in a private office, from a call centre or 

from home. It is often the case that telemarketers never met their 

customers’ face to face, so good telemarketing skills are of utmost 

importance to achieving success as a telemarketer. Follow these 

suggestions for how to be a good telemarketer. 

 

 Learn as much as you can about what you are selling. You 

should have a thorough understanding of what it is, how it 

works and how it may be useful to potential customers. 

Additionally, you should have genuine confidence in what you 

are selling, and in its value to the people you will be calling. 
 

 Learn about the company you work for. A good telemarketer 

not only sells a product or service, but also sells the company’s 

brand. You should be able to tell potential customers why they 

should choose you over your competitors. Study the company's 

history, philosophy, customer reviews/testimonials and 

industry ratings in order to be able to provide customers with 

a complete and favourable picture of who they are dealing 

with. 
 

 Make sure you understand the sales process. Once you 

convince a customer to invest in what you are selling, good 

telemarketing skills require that you are able to explain the 

sales process from start to finish. This includes closing 

paperwork, billing, shipping, refund/return policies, customer 

support and any necessary follow-up. 
 

 Compile contact information for your customers. You should 

have the business name, mailing address, phone number(s), 

email address, website, your manager's relevant information 

(especially if you work in a call centre) and any other 

pertinent contact information that your customers may ask for 

over the telephone. 
 

 Practice your script. Read it aloud until you are comfortable 

that you can deliver it without any prompts. 

 

Express confidence 
 

A good telemarketer speaks with a tone of authority that puts 

customers' minds at ease. If you are amply prepared, then you 

should be able to talk about the reason for your call and your 

company with confidence. 

 

 

 

 

Relevant Knowledge 
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Suppose you have to sell a product (e.g. medical equipment) to the customer. Write the conversation that 
will take place between you and the customer.  
 

Practice effective communications skills 

 

 Speak slowly, loudly and clearly enough so that customers can 

easily understand your conversation. Do not mumble. 

 

 Be considerate of the people you are calling. Introduce 

yourself and explain the purpose of your call as soon as 

possible in the conversation. Pause and take time to listen to 

responses as you go. 

 
 Find the right balance between saying too much and not saying 

enough. Dead air during a telephone conversation can be 

uncomfortable. On the other hand, you can overwhelm and 

confuse a potential customer by saying too much, too fast. 

 
 Avoid distracting conversation spacers such as, "um" and "ah." 

 

Try not to sound rehearsed 

 

Scripts are common in telemarketing, especially in a call centre 

atmosphere, but it is possible to deliver a script without sounding 

like you are reading from a piece of paper. Take some slow breaths 

and relax before making your calls, then focus on the message 

behind what you are saying rather than the words themselves. 

 

Maintain a positive mental attitude 

 

Remember that some (or many) of the people you call may not be 

expecting your call and, additionally, may not be receptive to your 

call.  

 

It is not unusual for even a good telemarketer to be rejected by 

several potential customers in a row before reaching an interested 

customer. Do not take rejections personally but, rather, take them 

as opportunities to develop your telemarketing skills. 

 

Stay resilient 

 

Telemarketing is a numbers game, and it takes time and persistence 

to develop good telemarketing skills. Commit to making a certain 

number of calls each day and see those calls through. 

 

Recognize when it is time to move on to the next call 

 

If a contact is expressly not interested in what you have to say, then 

politely end the call and move on to the next call.  

 

Exercise 
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__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 

 
 

 
 
Fill in the blanks 
 
 

1. Telemarketing is an act of selling goods and services to potential customers over _________________.  

2. A telemarketer is responsible for _____________ and services to potential customers over telephone. 

3. A good telemarketer speaks with a tone of ______________ that puts customer’s minds at ease. 

4. A good telemarketer not only sells a product or service, but also sells the company’s ____________. 

5. While talking to a customer on telephone, you should speak ___________, loudly and 

_________________ so that customers can easily understand your conversation. 

 
 

 
Use the following checklist to see if you have met all the requirements for assessment activity:  
 

Part A 
 
Differentiated between the following: 
 

 
Direct marketing and telemarketing 
 
Part B 
 
Discussed in class the following: 
 
1. Preparation before receiving the call 

2. How to build positive mental attitude while talking on telephone to a customer? 

 
Part - C 
 
Performance Standards 
 
The performance standards may include, but not limited to: 
 

Performance Standards Yes No 

Demonstrated the skill of talking to a potential customer on telephone for 
convincing him/her about a good or service provided by a healthcare equipment 
company  

  

 

Assessment  

Checklist for Assessment Activity 
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Session 3: Handling Customer Complaints 
 

In the session, you will learn how to handle complaints from various types of customers. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WHAT GOOD CUSTOMER 
SERVICE MEANS? 

 
 
 
 
 
 
 
 
 
 
 
 
 

Managing and maintaining good relations with customers is the duty 

of every individual in an organization, particularly the salesperson. 

Customer relationship, management includes identification of 

customer needs, effective communication competencies, 

resolution of a conflict situations and addressing the concerns of 

the customer by overcoming challenges that may emerge during 

provision of services.  
 

Handling Customers 
 

 Identifying the needs of the customer: This is needed to 

specifically address the need of the client.  

 

 Effective Customer Communication: The staff should 

overcome barriers in communication, if any, and ensure that 

reasonable customer suggestions or corrections are taken 

immediately. Note of suitable follow up action should be taken 

quickly and a feedback should be provided in all cases.It would 

be useful to develop a mechanism where customers could raise 

their issues on which action is taken. 

 

 Addressing Grievances: If despite best efforts, the customers 

have any grievance, it should be promptly addressed. Proper 

review of all grievances and action taken should be maintained. 

If a particular issue cannot be resolved, it should be escalated 

to higher levels. 

At some point, everyone in business has to deal with an upset 

customer. The challenge is to handle the situation in a way that 

leaves the customer thinking you operate a great company. If you 

are lucky, you can even encourage him or her to serve as a 

passionate advocate for your brand. 

 

When it comes down to it, many customers do not even bother to 

complain. They simply leave and buy from your competitors. 

Research suggests that up to 80 percent of customers who leave 

were, in fact, "satisfied" with the original company. Obviously, 

customer satisfaction is not enough. Businesses nowadays need to 

positively delight customers if they want to earn their loyalty.  

 

It may seem counter-intuitive, but a business owner’s ability to 

effectively deal with customer complaints provides a great 

opportunity to turn dissatisfied customers into active promoters of 

the business.  

 

 

 

 

 

Relevant Knowledge 
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Listen carefully to what the customer has to say, and let them 

finish 

 

Don't get defensive. The customer is not attacking you personally; 

he or she has a problem and is upset. Repeat back what you are 

hearing to show that you have listened.  

 

Ask questions in a caring and concerned manner 

 

The more information you can get from the customer, the better 

you will understand his or her perspective.  

 

Put yourself in customer’s shoes 

As a salesperson, your goal is to solve the problem, not argue. The 

customer needs to feel like you are on his/her side and that you 

empathize with the situation.  

 

Apologize without blaming 

 

When a customer senses that you are sincerely sorry, it usually 

diffuses the situation. Don't blame another person or department. 

Just say, "I'm sorry about that.” 

 

Become a partner with the customer in solving the problem 

 

Ask the customer, "What would be an acceptable solution to 

you?" 

Whether or not the customer knows what a good solution would be. 

 

Solve the problem, or find someone who can solve it quickly! 

When complaints are moved up the chain of command, they 

become more expensive to handle and only add to the customer's 

frustration. 

 

Negative word of mouth is spread and believed at twice the rate of 

positive word of mouth. Things customers say they value highly 

include: 

 

 having a problem fixed first time, and on time 

 having confidence that you know what you are doing 

 not being blamed for the problem 

 showing concern for their situation 

 being kept informed of progress 

 being advised what they can do to help avoid the problem 

recurring. 

 

Handling complaints 
 

Examples of poor complaint handling which we have seen include: 

 

 Not having any way for customers to make their complaints to 

you 

 Not having a system to record complaints 
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 Failing to acknowledge there is a problem 

 Not taking responsibility for the problem, and repeatedly 

giving the customer the run-around by making them deal with 

other staff 

 Blaming the customer for the problem, or saying no-one else 

has complained 

 Lack of knowledge of the problem 

 Lack of knowledge of consumer law 

 Taking too long to respond 

 Having staff with no authority to make decisions to help the 

customer 

 Offering no solution or offering a solution which is unlikely to 

resolve the problem 

 Promising to contact the customer and not doing so. 

 

The following checklists include ideas to help achieve the above 

principles and to help you develop good complaints handling 

systems. 

 

Reporting the problem 

 

Ensure that your contact details are readily available to customers. 

 

When the problem is reported 

 

 Thank the customer for bringing the problem to your 

attention. 

 Treat the customer with empathy, courtesy, patience, 

honesty and fairness. 

 Speak to the customer in person, and do not rely solely on 

written complaints, or records of conversations. 

 Show the customer that you clearly understand the problem 

by listening and taking notes. 

 Ask questions to clarify the situation. 

 Do not jump to conclusions or become defensive. 

 Summarise back to the customer your understanding of the 

problem. 

 Respond to the problem quickly, tell the customer how it will 

be handled and tell him/her when they can expect a 

response. 

 

Solving the problem 

 

 Tell the customer you are taking responsibility for dealing 

with the problem. 

 Familiarise yourself with any background information. This 

could include checking internal records, speaking to staff 

and checking how this compares with the customer's version 

of events. 

 Be solution-focused by involving the customer in this 

process. 

 Make sure the customer is happy with the proposed solution 

before going ahead. 
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Visit a nearby customer care service centre and prepare a report on the procedure followed by the person 

at the customer care service desk in handling complaints of customers. Record the discussion and express 

your opinion and ideas on the ways the person could have handled the customer more effectively. 

 

Role Play  

 

Salesperson: “Good Afternoon Sir. Welcome to Wonderful Mobile Phone Store. My name is Mahesh. May I 

help you?  

Customer: I bought this phone from your shop last week and it has not worked right at all! The battery 

does not work long and the phone drops calls everywhere I go. I need my money back.  

 

Write in the space given below about “How would you respond?” to the customer’s complaint. 

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

 Ensure that the solution meets any legal obligations. If the 

customer is asking for more than their legal right and you 

feel they are making an unrealistic demand, explain what 

the law says.  

 Where there are no legal obligations, offer a solution that in 

the circumstances best meets the needs of your business.  

 Make sure you do what you promised to do, and do not delay 

– quick action will keep customers happy, but stalling and 

delays will lose customers. If there is going to be a delay, 

tell the customer. 

 Tell the customer what your business will do to prevent the 

problem from happening again. 

 

Following up after the problem 

 

 Keep a record of the complaint, and what you have agreed 

with the customer. 

 Invite the customer to inform you promptly if they are not 

satisfied. 

 Keep a record of all problems and complaints raised. 

 Use these records to help you evaluate your complaint 

handling systems. They can help you identify recurring 

problems with particular goods you sell or services you offer. 

 Check how well and how quickly complaints could be 

handled. 

 

 
 
 

Exercise 
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__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________ 

 

 
 
Short Answer Questions 
 
1. What is the meaning of good customer service? 
 

__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 

 
2. After solving any issue, how will you follow up with the customer? 
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 

 

 
 
Use the following checklist to see if you have met all the requirements for assessment activity: 
 
Part – A 
 

Differentiated between the following: 
 
Customer complaint and customer query 
 
Part – B 
 

Discussed in class the following: 
 

1. Handling complaints 

2. Procedure for reporting a problem to the supervisor  

 

Part - C 
 

 
Performance Standards 
 

The performance standards may include, but not limited to: 
 

Performance Standards Yes No 

Demonstrated the skill of handling demanding customer’s     

Demonstrated the skill of handling customers in difficult situations   

 

Assessment  
 

Checklist for Assessment Activity 
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Session 4: Answering Enquiries 
 

In this session, you will learn how to answer enquiries of customers. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Answering customer’s questions or queries is a major part of many 

people who are into sales jobs. Some people can answer customer’s 

question if they are knowledgeable of the company’s products or 

services. While this may not be true in some cases. In reality, there 

is so much more to consider when answering questions than just 

having product knowledge. For instance, if a customer asks you for 

the balance due on his account, you can quickly give it to him or 

provide the balance along with additional information that the cus-

tomer could benefit from—maybe a special offer coming up next 

month. 

 

Types of Queries 

 

Customer may have general enquiries related to the products or 

may have queries related to handsets, order completion or bills.  

 

Answering with Style 

 

As simple as it may sound, there is an art to answering customer’s 

questions with style. Below are a few tips for you to keep in mind 

when you are faced with customer’s questions: 

 

 Use a positive tone of voice –You can say the exact same thing 

with two different tones of voice, and the messages will be 

perceived differently. Whether in person, on the phone, or in 

writing, the tone of voice you exude can affect how you are 

perceived in your customers’ eyes. No matter what, when 

answering your customers’ questions, always project a confi-

dent and pleasant tone of voice, even if the customers are not 

very pleasant with you. 

 

 Be professional – Choose your words carefully, use correct 

grammar, and avoid using jargon that your customers may not 

be familiar with. In addition to avoiding jargon, you also want 

to stay away from using slang terms. 

 

 Be aware of your rate of speech –Do not talk so fast that cus-

tomers do not understand what you want to convey. Speak at 

a natural pace that is not too slow and not too fast.  

 

 Empathize with the customer– If customers are upset, many 

a times they want you to know what they are experiencing. 

What they are looking for is some sort of empathy and a solu-

tion. In this day and age, empathy seems to be overlooked, 

and many agents just focus on a solution. Nothing can upset 

your customers more than not listening to them and not 

acknowledging their feelings before giving them an answer.  

 

 

Relevant Knowledge 
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Confirm your understanding 

 

In order to help your customer, you have to fully understand what 

he or she wants, and make sure that you are both on the same 

page.  

 

If applicable, offer your customer options – Give your customers 

all the options available to them, and point out the value that each 

option offers to the customer.  

 

Keep a catalogue or specification sheet about products, warranties 

and contracts close at hand when you answer customer service 

calls. This will give you a quick reference for answering questions. 

 

Allow the customer to explain the question or issue 

 

A customer with questions will likely have an explanation of the 

situation that caused the question to arise. Let the customer 

explain the question fully without interrupting so you understand 

what the customer is asking. 

 

Take notes 

 

Note down key words or notes while the customer is asking a 

question. Include key details that are being asked and any 

pertinent information the customer offers that will be pertinent in 

answering the customer's question. This allows you to retain 

information without interrupting. 

 

If required, seek information or help from a colleague if they 

cannot answer their customer’s query or request 

 

Repeat the question to the customer 

 

Summarize and restate the customer's question back to him or her 

to be sure you understand what is being asked or what needs to be 

resolved. This technique lets the customer know you are listening 

and helps you verify the information. 

 

Keep language positive 

 

Avoid telling the customer with a question that something cannot 

be done or would never happen. This negative language is 

dismissive and could make the customer feel that you donot care 

about answering the question and helping him or her. 

 

Promise only what you can deliver 

 

Give a customer an exact date of delivery only if you can guarantee 

it. Making false statements about the delivery will result in a 

dissatisfied customer. 

 

Exercise 
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Visit a retail store selling healthcare equipment and discuss with the salesperson or owner of the store 

about the most frequently asked questions by the customers on the goods and services provided by the 

store. 

 

 

 

Fill in the blanks 

 

1. Do you have ______________ ? 

2. Can I ________________this brand of mobile? 

3. Why haven’t you got _________________? 

4. Why has the ___________________ gone up? 

5. How _________discount you will give on this product? 

6. Where can I ___________________ the cover of this mobile? 

7. Can you tell me ___________________ this mobile? 

8. How do I make a ___________________ about this product? 

9. Where is this shop _______________________? 

10. Do you have an _________________________ for this item? 

11. How long is the ______________ on for? 

12. What is it _______________ from? 

13. How does it ___________________? 

14. What colours/____________________/weights are available? 

 
 
 
Use the following checklist to see if you have met all the requirements for assessment activity: 
 
Part - A 
 
Differentiated between query and enquiry. 
 
Part - B 
 

Discussed in class the following: 
 
 

1. How to answer enquiries related to healthcare equipment? 
2.  How to answer enquiries related to brands of a product? 
 
Part - C 
 

Performance Standards 
 

The performance standards may include, but not limited to: 
 
 

Performance Standards Yes No 

Demonstrated the knowledge of recognising and dealing with customer queries, 
requests and complaints 

  

 

Assessment  
 

Checklist for Assessment 
Activity 
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Session 1: Components of Human Eye 
 

In this session, you will learn about the different parts of human eye and how it is functionally connected to 

the human body. 

 

 

 
 

 

 
 

i.huffpost.com 

 

 

 

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 

The human eye is one of the most important organs in the human body. 

It is very sensitive and exposed to a variety of diseases, therefore care is 

to be taken to protect it and keep safe. 

The cornea is the transparent front part of the eye that covers the iris, 

pupil, and anterior chamber. The cornea, with the anterior chamber and 

lens, refracts light, with the cornea accounting for approximately two-

thirds of the eye's total optical power. The cornea has unmyelinated 
nerve endings sensitive to touch, temperature and chemicals; a touch of 

the cornea causes an involuntary reflex to close the eyelid. Because 

transparency is of prime importance, the cornea does not have blood 

vessels; it receives nutrients via diffusion from the tear fluid through the 

outside surface and the aqueous humour through the inside surface, and 

also from neurotrophins supplied by nerve fibres that innervate it. 

 

 

 
 

micro.magnet.fsu.edu 

 

The sclera, also known as the white of the eye is the opaque, fibrous, 

protective, outer layer of the eye containing collagen and elastic fibre. 

In humans, the whole sclera is white contrasting with the coloured iris, 

but in other mammals the visible part of the sclera matches the colour 

of the iris, so the white part does not normally show. In the development 

of the embryo, the sclera is derived from the neural crest. In children, it 

is thinner and shows some of the underlying pigment, appearing slightly 

blue. In the elderly, fatty deposits on the sclera can make it appear 

slightly yellow. The sclera forms the posterior five-sixths of the 

connective tissue coat of the globe. It is continuous with the dura mater 

and the cornea, and maintains the shape of the globe, offering resistance 

to internal and external forces, and provides an attachment for the extra 

ocular muscle insertions. 

 

 

Relevant Knowledge 
 

http://en.wikipedia.org/wiki/Transparency_%28optics%29
http://en.wikipedia.org/wiki/Human_eye
http://en.wikipedia.org/wiki/Iris_%28anatomy%29
http://en.wikipedia.org/wiki/Pupil
http://en.wikipedia.org/wiki/Anterior_chamber_of_eyeball
http://en.wikipedia.org/wiki/Lens_%28anatomy%29
http://en.wikipedia.org/wiki/Refraction
http://en.wikipedia.org/wiki/Optical_power
http://en.wikipedia.org/wiki/Myelinated
http://en.wikipedia.org/wiki/Reflex_action
http://en.wikipedia.org/wiki/Eyelid
http://en.wikipedia.org/wiki/Blood_vessel
http://en.wikipedia.org/wiki/Blood_vessel
http://en.wikipedia.org/wiki/Diffusion
http://en.wikipedia.org/wiki/Aqueous_humour
http://en.wikipedia.org/wiki/Human_eye
http://en.wikipedia.org/wiki/Collagen
http://en.wikipedia.org/wiki/Elastic_fiber
http://en.wikipedia.org/wiki/Embryo
http://en.wikipedia.org/wiki/Neural_crest
http://en.wikipedia.org/wiki/Connective_tissue
http://en.wikipedia.org/wiki/Globe_%28human_eye%29
http://en.wikipedia.org/wiki/Dura_mater
http://en.wikipedia.org/wiki/Cornea
http://en.wikipedia.org/wiki/Extraocular_muscle
http://en.wikipedia.org/wiki/Extraocular_muscle
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Three Layers of Human Eye 

 

The eyeball (globe or bulb) has three concentric coverings. 

 

 an external, fibrous tunic comprising the cornea and sclera; 

 a middle, vascular tunic comprising the iris, ciliary body, and 

choroid; and  

 an internal, nervous tunic, or retina. 

 

External fibrous tunic  

 
The cornea is the anterior, transparent part of the eye, and it forms 

about one-sixth of the circumference of the fibrous coat. Most of the 

refraction by the eye takes place not in the lens but at the surface of the 

cornea. The cornea is continuous with the conjunctiva and the junctional 

region is known as the limbus. The cornea is supplied by the ophthalmic 

nerve (from the fifth cranial nerve) by means of its ciliary branches. The 

eyelids close on stimulation of the cornea. The cornea is vascular and 

consists of five layers histologically: a largely collagenous 

substantiapropria enclosed by anterior and posterior epithelia and 

limiting laminae.  

 

Middle vascular tunic 

 

The middle tunic, frequently termed the uvea, comprises the choroid, 

the ciliary body, and the iris, from posterior to anterior. 

 

 The choroid is a vascular, highly pigmented coat that lines most of 

the sclera.  

 The ciliary body connects the choroid with the iris. The part near the 

choroid is a smooth ciliary ring (pars plana), whereas that near the 

iris is a ridged crown (pars plicata). The ciliary body contains the 

ciliary muscle and the ciliary processes, and is lined by the ciliary 

part of the retina.  

 

Internal nervous tunic (retina)  

 
The retina contains special receptors on which the inverted image of 

object is seen. Because of the partial crossing of nerve fibres at the optic 

chiasma, the retina of each eye is connected with both right and left 

visual areas of the forebrain. The retina is shaped like a sphere that has 

had its anterior segment removed, leaving an irregular margin, termed 

the oraserrata. The sensory elements of the retina end at the ora, but a 

pigmented continuation lines the ciliary body and the posterior part of 

the iris as the ciliary and iridial parts of the retina. 

 

The anterior segment is the front one third of the eye that includes the 

structures in front of the vitreous humour i.e. the cornea, iris, ciliary 

body, and lens. Within the anterior segment are two fluid-filled spaces 

i.e. the anterior chamber between the posterior surface of the cornea 

(i.e. the corneal endothelium) and the iris. 

 

http://en.wikipedia.org/wiki/Human_eye
http://en.wikipedia.org/wiki/Cornea
http://en.wikipedia.org/wiki/Iris_%28anatomy%29
http://en.wikipedia.org/wiki/Ciliary_body
http://en.wikipedia.org/wiki/Ciliary_body
http://en.wikipedia.org/wiki/Lens_%28anatomy%29
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Draw a diagram of the eye and label the following parts: 
 
a) Fibrous tunic 
b) Iris 
c) Retina 
d) Lens  
 

 
 
 

I. Multiple Choice Questions 
 

1. The transparent front part of the eye is 
 

(a) Sclera 
(b) Cornea 
(c) Retina 
(d) Iris 
 
2. The junctional region of cornea is known as  

 
(a) Uvea 
(b) Choroid 
(c) limbus 
(d) Sclera 
 
3. ____________________forms the posterior five-sixths of the connective tissue coat of the globe 

 
(a) Cornea 
(b) Sclera 
(c) Iris 
(d) Ciliary Body. 
 
4. _______________is the front one third of the eye that includes the structures in front of the vitreous 

humour 
 

(a) Cornea 
(b) Iris 
(c) Anterior segment 
(d) Posterior segment 

 
5. ________________is the chamber between the posterior surface of the cornea and the iris. 

 
(a) Limbus 
(b) Posterior Chamber 
(c) Oraserrata 
(d) Anterior chamber 
 
 

The posterior segment is the back two-thirds of the eye that includes 

the anterior hyaloid membrane and all of the optical structures behind 

it i.e. the vitreous humor, retina, choroid, and optic nerve. The posterior 

segment is the back two-thirds of the eye that includes the anterior 

hyaloid membrane and all structures behind it: the vitreous humor, 

retina, choroid, and optic nerve. 

Assessment  
 

Exercise 
 

http://en.wikipedia.org/wiki/Connective_tissue
http://en.wikipedia.org/wiki/Globe_%28human_eye%29
http://en.wikipedia.org/wiki/Human_eye
http://en.wikipedia.org/wiki/Vitreous_humour
http://en.wikipedia.org/wiki/Vitreous_humour
http://en.wikipedia.org/wiki/Human_eye
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II. Fill in the Blanks 

 

1. The _______________is the transparent front part of the eye that covers the iris, pupil, and anterior 

chamber.  

2. The __________________also known as the white of the eye, is the opaque, fibrous, protective, outer 

layer of the eye containing collagen and elastic fibre. 

3. In the development of the __________the sclera is derived from the neural crest.  

4. The cornea is continuous with the conjunctiva and the junctional region is known as the ______________ 

.  

5. The ______________segment is the front one third of the eye that includes the structures in front of the 

vitreous humour i.e. the cornea, iris, ciliary body, and lens.  

6. The ____________ segment is the back two-thirds of the eye that includes the anterior hyaloid membrane 

and all of the optical structures behind it i.e. the vitreous humor, retina, choroid, and optic nerve. 

 

 

 

Use the following checklist to see if you have met all the requirements for assessment activity: 

 

Part A 

 

Differentiated between the following: 

 

1. Cornea and Sclera 

2. Anterior segment and posterior segment 

 

Part B 

 

Discussed in class the following: 

 

1. Different parts of human eye 

2. Different layers of human eye 

3. Functions of different parts of human eye. 

 

Part C 

 

Performance standards 

 

The performance standards may include, but not limited to: 

 

Performance Standards Yes No 

Identified the internal and external anatomy of the eye, naming and locating the 

following parts: cornea, iris, pupil, lens, retina, sclera, vitreous and aqueous 

humours, choroid, optic nerve and blind spot 

  

  

Checklist  for Assessment Activity 
 

 

http://en.wikipedia.org/wiki/Transparency_%28optics%29
http://en.wikipedia.org/wiki/Human_eye
http://en.wikipedia.org/wiki/Iris_%28anatomy%29
http://en.wikipedia.org/wiki/Pupil
http://en.wikipedia.org/wiki/Anterior_chamber_of_eyeball
http://en.wikipedia.org/wiki/Anterior_chamber_of_eyeball
http://en.wikipedia.org/wiki/Human_eye
http://en.wikipedia.org/wiki/Collagen
http://en.wikipedia.org/wiki/Neural_crest
http://en.wikipedia.org/wiki/Human_eye
http://en.wikipedia.org/wiki/Cornea
http://en.wikipedia.org/wiki/Iris_%28anatomy%29
http://en.wikipedia.org/wiki/Ciliary_body
http://en.wikipedia.org/wiki/Lens_%28anatomy%29
http://en.wikipedia.org/wiki/Human_eye
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Session 2: Field of View and Dynamic Range of Human Eye 
 

In this session, you will learn about field of view and dynamic range of human eye. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Eyeball acts as a Camera. It perceives the image and relays the 

sensation to the occipital cortex of the brain via visual pathway 

which comprise optic nerve, optic chiasma, optic tract, lateral 

geniculate body and optic radiations. 

 
Field of view 

 
The field of view is the extent of the observable world that 

is seen at any given moment. In the context of human vision, the 

term "field of view" is typically used in the sense of a restriction 

to what is visible by external apparatus, like spectacles. The 

approximate field of view of an individual human eye is 95° away 

from the nose, 75° downward, 60° toward the nose, and 60° 

upward, allowing humans to have an almost 180-degree forward-

facing horizontal field of view. With eyeball rotation of about 90° 

(head rotation excluded, peripheral vision included), horizontal 

field of view is as high as 270°. About 12–15° temporal and 1.5° 

below the horizontal is the optic nerve or blind spot which is 

roughly 7.5° high and 5.5° wide. 

 

Dynamic range 

 
The retina has a static contrast ratio of around 100:1 (about 6.5 f-

stops). As soon as the eye moves (saccades) it re-adjusts its 

exposure both chemically and geometrically by adjusting the iris 

which regulates the size of the pupil. Initial dark adaptation takes 

place in approximately four seconds of profound, uninterrupted 

darkness; full adaptation through adjustments in retinal chemistry 

(the Purkinje effect) is mostly complete in thirty minutes. The 

process is nonlinear and multifaceted, so an interruption by light 

merely starts the adaptation process over again. Full adaptation is 

dependent on good blood flow; thus dark adaptation may be 

hampered by poor circulation, and vasoconstrictors like tobacco. 

 

The human eye can detect a luminance range of 1014, or one 

hundred trillion (100,000,000,000,000) (about 46.5 f-stops), from 

10−6 cd/m2, or one millionth (0.000001) of a candela per square 

meter to 108 cd/m2 or one hundred million (100,000,000) candelas 

per square meter. This range does not include looking at the 

midday sun (109 cd/m2) or lightning discharge. 

 

 

 

Relevant Knowledge 
 

http://en.wikipedia.org/wiki/Field_of_view
http://en.wikipedia.org/wiki/Blind_spot_%28vision%29
http://en.wikipedia.org/wiki/Contrast_ratio
http://en.wikipedia.org/wiki/F-number#Stops.2C_f-stop_conventions.2C_and_exposure
http://en.wikipedia.org/wiki/F-number#Stops.2C_f-stop_conventions.2C_and_exposure
http://en.wikipedia.org/wiki/Saccade
http://en.wikipedia.org/wiki/Purkinje_effect
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At the low end of the range is the absolute threshold of vision for 

a steady light across a wide field of view, about 10−6 cd/m2 

(0.000001 candela per square meter).The upper end of the range 

is given in terms of normal visual performance as 108 cd/m2 

(100,000,000 or one hundred million candelas per square meter). 

 

The eye includes a lens similar to lenses found in optical 

instruments such as cameras and the same principles can be 

applied. The pupil of the human eye is its aperture and the iris is 

the diaphragm that serves as the aperture stop. Refraction in the 

cornea causes the effective aperture (the entrance pupil) to differ 

slightly from the physical pupil diameter. The entrance pupil is 

typically about 4 mm in diameter, although it can range from 

2 mm (f/8.3) in a brightly lit place to 8 mm (f/2.1) in the dark. 

The latter value decreases slowly with age; older people's eyes 

sometimes dilate to not more than 5-6mm. 

 

Monocular vision is vision in which both eyes are used separately. 

By using the eyes in this way, as opposed by binocular vision, 

the field of view is increased, while depth perception is limited. 

Monocular vision affects how the brain perceives its surroundings 

by decreasing the available visual field, impairing peripheral vision 

on one side of the body, and compromising depth perception, all 

three of which are major contributors to the role of vision in 

balance. Most birds have monocular vision. With their eyes on each 

side of their head, it gives them a greater field of view, which is 

useful for spotting predators. However, they have poor depth 

perception. 

 

Binocular vision is vision in which creatures having two eyes use 

them together. It is the ability to maintain visual focus on an 

object with both eyes, creating a single visual image. Inocular 

vision is generally considered to be able to look at the same object 

at the same time with both eyes, thus giving us perception of 

depth. Binocular vision can be divided into three levels of 

functionality: (i) Seeing with both eyes simultaneously- the ability 

to process images from both eyes at the same time; (ii) Fusion – 

two images is merged into one. The brain is able to interpret the 

two different images from right and left eye correctly and is able 

to give a single image as output. This happens if we are able to 

direct the two eyes in the same direction and focus on the same 

object. With the information from two eyes, most of us have a 

slightly higher visual acuity than with only one eye; (iii) Stereopsis 

– distance, depth and direction- It is our ability to see three 

dimensional. This depth of vision comes from the small differences 

in the images from the two eyes. The brain uses these clues to 

help us assess distance to objects.  Binocular vision is required for 

driver’s license. It is also important for catching a ball and many 

other coordinated operations. 

 

 

http://en.wikipedia.org/wiki/Absolute_threshold
http://en.wikipedia.org/wiki/Lens_%28anatomy%29
http://en.wikipedia.org/wiki/Lens_%28optics%29
http://en.wikipedia.org/wiki/Pupil
http://en.wikipedia.org/wiki/Eye
http://en.wikipedia.org/wiki/Aperture
http://en.wikipedia.org/wiki/Cornea
http://en.wikipedia.org/wiki/Entrance_pupil
https://en.wikipedia.org/wiki/Visual_perception
https://en.wikipedia.org/wiki/Human_eyes
https://en.wikipedia.org/wiki/Binocular_vision
https://en.wikipedia.org/wiki/Field_of_view
https://en.wikipedia.org/wiki/Depth_perception
https://en.wikipedia.org/wiki/Visual_perception
https://en.wikipedia.org/wiki/Eye
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I. Fill in the Blanks 

1. The retina has a static contrast ratio of around ___________. 

2. Optic disk is also known as the _________________. 

3. The human eye can detect a luminance range of ______________. 

4. The eye includes a lens similar to lenses found in ________________. 

5. The optic disk is __________ in shape. 

 
II. Short Answer Questions: 
 
1. Describe the field of view of human eye. 

 
_____________________________________________________________________________________________
_____________________________________________________________________________________________
_____________________________________________________________________________________________
_____________________________________________________________________________________________ 
 

2. Explain the dynamic range of human eye. 
 
_____________________________________________________________________________________________
_____________________________________________________________________________________________
_____________________________________________________________________________________________
_____________________________________________________________________________________________ 
 

 
 
Use the following checklist to see if you have met all the requirements for assessment activity: 
 
Part A 
 
Differentiated between the following: 
 
Monocular and binocular vision 
 
Part B 
 
Discussed in class the following: 
 
Human eye range 
 
Part C 
 
Performance standards 
 
The performance standards may include, but not limited to: 
 

Performance standards Yes No 

Demonstrated an understanding that light is focused on the retina by the action of 

the lens and cornea 

  

Explained the difference between monocular vision and binocular vision   

 

 Assessment  

 Checklist for Assessment Activity 

http://en.wikipedia.org/wiki/Contrast_ratio
http://en.wikipedia.org/wiki/Lens_%28anatomy%29
http://en.wikipedia.org/wiki/Lens_%28optics%29
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Types of eye movements 

 

Although the eyes can be moved voluntarily, most eye movements 

are through reflexes. The principal types of movement include 

voluntary motion (both vertical and horizontal), tracking (both 

voluntary and involuntary) and convergence. Additionally, there are 

pupillary reactions and control of the lens. The retina is a light-

sensitive layer at the back of the eye that covers about 65 percent 

of its interior surface. Photosensitive cells called rods and cones in 

the retina convert incident light energy into signals that are carried 

to the brain by the optic nerve. In the middle of the retina is a small 

dimple called the fovea or fovea centralis. It is the center of the eye's 

sharpest vision and the location of most colour perception. 

Muscles of the eye 

Eye position and motion is controlled by six muscles in each eye. All 

muscles are tonically active to maintain stability of the eyes. Each 

eye can be adducted, abducted, elevated, depressed, intorted or 

extorted. Additionally, this motion must be conjugate in order to 

prevent diplopia. Horizontal eye movements are controlled by the 

medial and lateral rectus muscles (adduct and abduct the eyes, 

respectively). Every movement that elevates the eye above or 

depresses below the horizontal plane requires the participation of at 

least two muscles because the axis of the orbit and the muscles of 

the eye are not directly in line with the visual axis. Accordingly, 

isolated contraction of the superior or inferior rectus muscles or the 

superior or inferior oblique muscles results in torsion and deviation 

of the eye during the process of elevation and depression. For this 

reason, at least two muscles are primarily active whenever the eyes 

are elevated or depressed. When looking straight up, the superior 

rectus and inferior oblique act together. Looking straight down 

employs the inferior rectus and superior oblique. The six positions of 

gaze are used to simplify analysis of eye muscle weakness. 

Extraocular cranial nerves and nuclei 

There are three cranial nerves innervating eye muscles. The 

oculomotor nerve, CNIII, innervates all of the extraocular muscles 

with the exception of the lateral rectus and superior oblique. It also 

innervates the elevator of the upper lid. These motor nerve fibres 

arise from the oculomotor nucleus, located within the midbrain just 

ventral to the periaqueductal gray. In addition to motor nerve fibres, 

the oculomotor nerve contains parasympathetic preganglionic nerve 

fibres. These nerve fibres synapse in the ciliary ganglion with 

Session 3: Movements of Human Eye 

In this session, you will learn about the various types of eye movements. 

Relevant Knowledge 
 

http://hyperphysics.phy-astr.gsu.edu/hbase/vision/rodcone.html#c1
http://hyperphysics.phy-astr.gsu.edu/hbase/vision/retina.html#c2
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postganglionic fibres going to the constrictor of the pupil and to the 

ciliary muscle. Contraction of the ciliary muscle results in the lens 

becoming rounder, to allow for close focus. The parasympathetic 

nerve fibres in the oculomotor nerve arise from the Edinger-Westphal 

nucleus, which is located in the midline between the left and right 

oculomotor nuclei. 

 

The oculomotor nerve leaves the midbrain in the interpeduncular 

fossa, passes between the superior cerebellar artery and the 

posterior cerebral artery and enters the dura. It passes through the 

wall of the cavernous sinus to reach the superior orbital fissure of the 

skull, which is how it enters the orbit. The cavernous sinus is 

immediately adjacent to the sellaturcica at the skull base, which 

contains the pituitary gland. 

Voluntary eye movements 

Voluntary eye movements occur in small jumps called saccades. 

These rapid movements occur so fast that the eye cannot see during 

the movement. Frequent small jumps (microsaccades) occur even 

when the eye is still.  

 

Voluntary horizontal gaze and vertical gaze utilize different neuronal 

circuitry. Voluntary conjugate horizontal gaze is initiated by neurons 

in the frontal eye fields of the cerebral cortex. Activation of the right 

frontal eye field will cause the eyes to look to the left and activation 

of the left frontal eye field will cause the eyes to look to the right. 

Projections from the frontal eye field go directly and indirectly (via 

the superior colliculus) to the contralateral paramedianpontine 

reticular formation (the PPRF). The PPRF, the region of reticular 

formation immediately ventral to the abducens nucleus, contains 

neurons that are critical for generating horizontal saccades. Damage 

to the left PPRF, for example, will completely prevent the movement 

of either eye to the left. 

Vestibulo-ocular reflex 

The vestibulo-ocular reflex (VOR) produces eye movement in 

response to changes in head position. This is an extraordinarily 

accurate reflex that allows the eyes to remain focused on a target 

when the head moves. This is reflected in a 1:1 "gain" of this reflex 

(i.e., 3 degrees of head motion should cause an opposing 3 degrees 

of eye movement). Projections from the vestibular nerve terminate 

in the vestibular nucleus and cerebellar flocculus. Many neurons in 

the vestibular nucleus project to the extraocular nuclei and 

paramedianpontine reticular formation. The medial longitudinal 

fasciculus carries many of these connections. With abnormal 

vestibular input, the eyes will drift away from the direction of 

perceived motion (vertigo). However, if the person is awake, there 

will be saccades to reacquire the visual image as it begins to drift. 

This is the substrate for jerk nystagmus. 
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The VOR is a reflex response that must be adjusted over time. For 

example, if there is damage to the vestibular apparatus of an ear, 

there will be diminished input on that side. Nonetheless, the reflex 

must still maintain a "gain" of 1:1 causing the eyes to move contrary 

to head movement if vision is to be stabilized.  

Tracking/smooth pursuit eye movements 

Most of our normal voluntary eye movements are not smooth, but 

rather occur in saccades. However, we are able to move our eyes 

smoothly when tracking a moving object. Smooth pursuit eye 

movements utilize some of the vestibuloocular reflex pathways and 

require a visual input to the occipital cortex in order to permit 

locking of the eyes onto the target. The occipital eye fields are not 

as well defined as the frontal eye field. They are located in the region 

near the junction of the occipital lobes with the posterior parietal 

and temporal lobes (including visual association areas that are 

involved in detecting motion). 

 

There are two reflexes that use the same wiring as smooth pursuit 

movements. These are the fixation reflexes and the optokinetic 

reflexes. "Fixation reflex" refers to the ability to fixate on a target 

that is moving. When the head is moving this reflex complements the 

VOR to stabilize the eyes. The optokinetic reflex (nystagmus; OKN) is 

an involuntary fixation on objects that are moving in relationship to 

the head. This is classically observed when looking out of the side of 

a moving vehicle and has been termed "railway nystagmus". The eyes 

will have the tendency to track moving objects, especially if they 

have very starkly contrasting features. They will track for a distance 

and then subsequently saccade in the opposite direction to reacquire 

a target. If one visual cortex is damaged, optokineticnystagmus will 

be lost when objects move toward the side of the cortex lesion (that 

is, if they approach an individual from the side of vision impairment). 

 
 

  
 
I. Short Answer Questions 
 
1. What is fovea centralis? 
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 
 
 

2. Name four types of eye movements. 
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 
 
 
 
 
 

Assessment  
 



104 | P a g e  
 

3. What is fixation reflex? 
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
 
4. Explain the different types of human eye movement. 
 
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 
 
5.  What are the different muscles of human eye? 
 
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 
 
6. What is VOR? Explain. 

 
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 
 
II. Fill in the Blanks 
 
1. In the middle of the retina there is a small dimple which is called the ___________. 
 
2. The motion of the eye must be conjugate in order to prevent ____________.  
 
3. Voluntary eye movements occur in small jumps called ________________.  
 
4. The ________________reflex produces eye movement in response to changes in head position.  
 
5. There are two reflexes that use the same wiring as smooth pursuit movements which are the 

______________ reflexes and the _____________ reflexes. 
 

 
 
 

Use the following checklist to see if you have met all the requirements for assessment activity: 

 

Part A 

 

Differentiated between the following:  

 

1. Saccades and microsaccades 

2. Fixation reflexes and optokinetic reflexes 

3. Vestibulo-ocular reflex and smooth-pursuit eye movements. 

 

 

 

 

 

 

Checklist for Assessment 
Activity 
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Part B 

 

Discussed in class the following: 

 

1. Vestibulo-ocular reflex  

2. Types of eye movements 

3. Saccades 

 

Part C 

 

Performance standards 

 

The performance standards may include, but not limited to: 

 

Performance Standards Yes No 

Differentiated between the different eye movements   
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Session 1: Eye Care Professionals 
 

In this session, you will study about roles and functions of Ophthalmologist, Optometrist and Orthoptist. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Ophthalmologists 

 
An Ophthalmologist is a specialist in medical and surgical eye 

problems. Since ophthalmologists perform operations on eyes, they 

are both surgical and medical specialists. A medical doctor 

specially trained in the medical and surgical care and treatment of 

eyes can be called as an Ophthalmologist. An advanced education 

and training is required to become an ophthalmologist.  In India, 

after completing MBBS (Bachelor of Medicine & Bachelor of Surgery) 

degree, postgraduate study in ophthalmology is required.  

 

Optometrists 

 
Optometrists need not have to study medicine like doctors. The 

optometrists provide only limited forms of eye care. Bachelor of 

optometry is a course of three years of education where students 

are trained to examine the eyes to determine the presence of a 

limited number and type of vision problems related to eye 

movement. Optometrists prescribe only the eyeglasses and contact 

lenses at the initial stages.  

 
Orthoptists 

 
Orthoptists are also not required to study medicine like the 

optometrists. It is a full time three-year degree course to specialize 

in Orthoptic treatment. Orthoptists deal with assessing, diagnosing 

and managing the patient with eye muscle disorders.  When 

appropriate, traditional Orthoptic exercise programmes are still 

employed. Othoptists work closely with ophthalmologists to confirm 

that the patient with eye muscle disorders are exposed to full range 

of treatment options. Orthoptists serve patients of all ages (adults 

and children). 

 
The programme of therapy is based on the results of standardised 

tests, the needs of patient and the patient’s symptoms. The 

exercises that the programme involves are the use of lenses, prisms 

filters, occludes, specialised instruments and computer 

programmes.  Some of the exercises related to orthoptic visual 

therapies are as follows: 

 

 Near point of convergence exercises. 

 Base out prism reading 

 The wearing of convex lenses 

 Cawthorne Cooksey exercise 

 Antisuppression exercise. 

 
 
 

Relevant Knowledge 
 

https://en.wikipedia.org/wiki/Specialty_(medicine)
https://en.wikipedia.org/wiki/Surgery
https://en.wikipedia.org/wiki/Medicine
https://en.wikipedia.org/wiki/India
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I. Short Answer Questions 
 
1. What is Ophthalmology? 

 
_________________________________________________________________________________
_________________________________________________________________________________
_________________________________________________________________________________ 
_________________________________________________________________________________ 
 

 
2. What is the role of Optometrists? 

 
_________________________________________________________________________________
_________________________________________________________________________________
_________________________________________________________________________________
_________________________________________________________________________________ 

 
3. What are the roles and functions of Ophthalmologists? 

_________________________________________________________________________________
_________________________________________________________________________________
_________________________________________________________________________________ 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
 

 
 
Use the following checklist to see if you have met all the requirements for assessment activity: 

 

Part - A 

 

Differentiated between the following:   

 

1. Ophthalmologists and Orthoptists. 

2. Optometrists and Orthoptists 

 

 

 

 

 

 

 

 

 

 

 

Behavioural Vision Therapy 

 
Developmental optometry is the therapy that is used in behavioural 

vision therapy which is further practiced by behavioural 

optometrists. Patients having difficulties in visual attention and 

concentration are the symptoms observed in behavioural vision 

therapy which is classified as visual information processing 

weakness by the behavioural optometrists. 

Assessment  
 

Checklist for Assessment Activity 
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Part – B 

 

Discussed in class the following: 

 

1. Who are Ophthalmologists?  

2. What are the functions of Ophthalmologists? 

 

Part - C 
 
Performance Standards 
 
The performance standards may include but not limited to: 
 

Performance Standards Yes No 

Differentiated between the role and functions of Ophthalmologists and Optometrists 
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Session 2: Basic Examination for Eye Diseases 
 

In this session, you will learn about the basic examinations related to eye disease and visual disorder. 

Your will also learn different terms and instruments related to eye tests. 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A series of tests are performed by an ophthalmologist, optometrist 

or orthoptist for assessing vision and the ability to focus or discern 

objects through an eye examination. People must have a routine 

eye check-up as it is being recommended by the health 

professionals as many eye diseases are asymptomatic. 

 

Through an eye examination, various eye diseases can be detected 

such as blinding eye disease, ocular manifestations of systematic 

disease, and signs of tumours and other anomalies of the brain. 

 

The eye examination consists of the following eye tests: 

 

Visual Acuity 
 

This test detects fine details and shows the quantitative measure 

of the eye’s ability to see an in-focus image at a certain distance. 

This visual ability of the eye can be defined as visual acuity. In 

simple words, Visual Acuity refers to the ability to discern the 

shapes and details of the things a person can see. The standard 

definition of normal vision acuity (20/20 or 6/6 vision) is the ability 

to view a special pattern. 

 

Normal vision is 20/20. This means that the test subject sees the 

same line of letters at a distance of 20 feet as does a person with 

normal vision.  The term 6/6 is more commonly used in Europe and 

Australia which is represented in meters. 

 

Visual acuity is measured in Snellen Chart. 

 

Refraction 
 

A process which eye care professionals use to measure the vision 

problem is refraction. The procedure by which any refractive error 

is characterized and qualified can be termed as refraction. An 

optical abnormality is the refractive error in which a corrective lens 

is required for proper focusing. A refraction error does not allow 

light to be brought into sharp focus on the retina as it results in 

blurred and distorted vision.  

 

The examples of refractive error are; myopia, hyperopia and 

astigmatism. Refraction consists of two parts- Objective Refraction 

and Subjective Refraction. 

 

 

 

 

 

Relevant Knowledge 
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(i) Objective Refraction 

 

A refraction which is obtained without any feedback from the 

patient is known as objective refraction. Objective refraction is 

obtained by using different instruments. To measure refraction 

without being asked for subjective responses the doctor uses 

retinoscopy or auto-refractor. Retinoscopy is an instrument used for 

objective refraction. 

 

Retinoscope 

 

Based on eye movement and orientation of retinal reflection the 

doctor gets the clear view of the refractive state of the patient’s 

eye and measures it. 

 

Auto refraction is an instrument used for objective refraction. This 

instrument is computerized instrument that shines light into the 

eye. The light travels through front part of the eye to the back part 

of the eye and then back again. 

 

Auto-refractors are quick and easy to use and do not require any 

feedback. 

 

(ii) Subjective Refraction  

 

A refraction that requires responses from the patient is known as 

subjective refraction. 

 

A phoroptor trial frame is used by the professionals to look at an 

eye chart through which a feedback from the patient is asked in 

order to select the best lenses where the vision is clear. 

 

Pupil Function 

 

For the assessment of optic nerve anomalies seining flashlight is 

used by the general physicians. This process is conducted in semi-

darkened room.  

 

During this process, in normal reaction to the swinging flashlight 

test, both pupils constrict when it shines on the right eye as because 

the left eye does not respond to external stimulus but can receive 

neural signs from the brain to constrict. 

 

Ocular Motility  

 

When the patient complains about double vision, ocular motility 

should always be tested for neurological disease. 

 

The patient is asked to move both of their eyes in each of the nine 

cardinal directions of the gaze. The extra ocular muscles are tested 

by the nine cardinal directions such as interior, superior, lateral, 

medial rectus muscles, superior and inferior oblique muscles. 
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Visual Field Testing 

 

Visual field testing is done to assess the extent of the peripheral 

field. The problems included in the visual field testing are scotma, 

hemianopia, homonymous hemianopsia and bitemporal 

hemianopia. 

 

External Examination 

 

Inspection of the eyelids, palpebral fissure, surrounding tissues, 

palpitation of the orbital involves external examination of the eyes. 

 

Slit–Lamp 

 

In this process, the patient is seated while examining and the head 

is stabilized by an adjustable chin rest.  

 

The ocular structures are examined by the examiner through an 

optical system that magnifies the image of the eye. 

 

Slit Illumination Techniques  

 

The ability to detect and observe various anterior segment 

condition depends on the observer to correctly adjust and position 

the illumination system of the slit lamp. The illumination 

techniques can be categorised into 4 main categories: 

(i) Diffuse illumination: A diffuse filter is placed in the focused 

light bean of the slit lamp. It gives an even broad illumination 

over the eye. 

Setting up diffuse illumination requires: 

 

(i) Angle between slit-lamp and microscope should be from 10-70 

degrees 

(ii) Wide beam  

(iii) Diffusing filter 

(iv) Low to medium magnification 

The slit lamp biomicroscope consists of 3 parts: 

 

(i) The observation system-includes microscope to obtain 

magnification 

(ii) The illumination system-the parts to be seen  

(iii) The mechanical support system-for accurate and convenient 

positioning of the eye and the instrument    

 

Direct Illumination 

 

Direct illumination means that the observing system is focusing 

directly at the area under illumination. 

 

 

 



114 | P a g e  
 

It is further classified into following: 

 

1. Optic section  

2. Parallelepiped  

3. Broad beam 

4. Conical beam 

5. Specular reflection  

Optic Section  

 

This technique utilizes a narrow, focused slit of 0.02 to 0.1 mm to 

produce a cross-section view especially of the cornea. 

 

To set up 

 

 30 to 60 degrees angle between observation and illumination 

system 

 Medium to high illumination 

 

Used to observe 

 

 Variation in corneal curvature 

 Corneal thickness 

 Depth of corneal opacities  

 Foreign body embedded in cornea 

Parallelepiped  

 

This illumination is same as optic section except that the beam is 

broader than optic section. The size of beam is 0.1 to 0.7 mm. This 

is most commonly used beam and is commonly used to observe. 

 

 Corneal stroma 

 Corneal endothelium  

 Corneal scarring 

 Corneal staining  

 Corneal infiltrates 

 Neovascularization  

 Striae and folds 

Broad Beam Illumination 

 

This is further widening of parallelepiped illumination beam to 1 to 

5 mm. 

 

This is used to observe: 

 

 Corneal nerve fibres  

 Debris beneath the contact lens 

 Conjunctival scars  
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Conical Beam Illumination  

 

This beam is utilized to observe the inflammatory or flair in the 

anterior chamber. 

 

To set up 

 

 Same as optic section  

 Reduce the height of the beam to 1 to 2 mm. 

 Focus on the iris first; slide forward the joystick to focus the 

cornea. Then move in between to observe the cells and flare 

 The room /background should be dark. 

Specular Reflection 

 

This illumination is an extension of parallelepiped illumination, 

where the angle of the incident slit beam to the corneal surface 

equals angle of observation axis when seen through one of the 

oculars. 

 

To set up 

 

 60 degrees angle between illumination and observation system  

 Parallelepiped  

 Move illumination arm until bright reflex is observed. At this 

point the angle of incidence is equal to angle of reflection. 

 See through one oculars. 

 Shift magnification to high now. 

 Observe the endothelium mosaic in the dull image next to the 

bright reflex. 

Used to Observe 

 

 Endothelial mosaic along with guttae, folds, blebs. 

 Tear layer stability and lipid layer. 

 Lens front surface wetting. 

Indirect Illumination 

 

This refers to any technique where the focus of the illumination 

beam does not collide with the observation system. The two major 

indirect illuminations are: 

 

 Retro-illumination  

 Sclerotic scatter 

Retro-illumination  

 

This is further of two types: 

 

 Direct  

 Indirect  
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The light is reflected off the iris or fundus while the microscope is  

focused on the cornea. 

 

To Set Up 

 

 Offset the slit-beam. 

 Create a parallelepiped beam. 

 Illuminate the area behind the corneal area to be seen. 

 Observe the cornea in the reflected light. 

 Direct – See the corneal just in front of the illuminated area 

 Indirect – See the corneal area adjacent to the illuminated area  

Used to Observe 

 

 Contact lens front and back surface deposits. 

 Neovascularization, edema 

 Microcsysts. 

 Infiltrates 

Sclerotic Scatter 

 

This is a type of indirect illumination.  

 

To Set Up 

 

 Utilize a parallelepiped technique. 

 Focus the beam on the nasal or temporal limbus. 

 Light from the slit is totally internally reflected and the cornea 

glows. 

 Observe the cornea against the bright glow. 

Used to Observe 

 

 Central corneal clouding  

 Corneal scars 

 Foreign body/deposits 

Filtered Illumination 

 

 Cobalt blue light and Wratten filter #12 – (yellow filter) is used 

to observe the corneal staining patterns and rigid gas permeable 

lens fitting relationship on the eye. This is frequently used 

illumination where the fluorescein dye and the filter is used to 

highlight the eye condition and the fitting. The yellow filter is 

an added attachment which when used with cobalt blue light 

enhances the contrast further and makes the observation 

easier. 

 

Abnormalities 

 

Checklist to be seen by slit lamp during contact lens examination: 

 

 Blepharities 

 Cornel infiltrates  

 Iritis 
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A. Fill in the blanks 

1. During ___________ examination the optic disc and ____________ __________ is viewed and the 

observations are recorded. 

2. In ____________ process the patient’s head is ___________ by an adjustable chin rest. 

3. __________ ___________ _________ is done to assess the extent of the peripheral field. 

4. A ___________ trial frame is used by the professionals. 

5. Auto refraction is an instrument used for ____________ ____________. 

 

B. Short Questions 
 
1. Name the different eye diseases? 

 
_________________________________________________________________________________
_________________________________________________________________________________
_________________________________________________________________________________
_________________________________________________________________________________ 

 
2. What is refractive error? 

_________________________________________________________________________________
_________________________________________________________________________________
_________________________________________________________________________________
_________________________________________________________________________________ 
 
 

 Ulcer 

 Papillae or any other tarsal conjunctival abnormalities  

 Corneal edema/striae/folds 

 Neovascularization 

 Corneal staining  

 Microcysts 

 Endothelial status 

Intraocular Pressure 

 

Intraocular pressure (IOP) is the fluid pressure inside the eye. By 

tonometry devices the intraocular pressure is measured.Tonometry 

is a device used to measure the pressure using various instruments. 

The normal range is 10-21 mmHg. 

 

Retinal Examination  

 

An important part of general eye examination is retinal 

examination. During fundus examination, the optic disc and retinal 

vasculature is viewed and the observations are recorded. This 

examination is done from a distance of about 50 cm and between 

the two eyes it is usually symmetrical. A cataract is indicated by 

opacity. 

Assessment  
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Use the following checklist to see if you have met all the requirements for Assessment Activity. 
 
Part – A 
 
Differentiated between the following: 
 
Different types of eye diseases. 
 
Part – B 
 
Discussed in class the following: 
 
1. Retinal examination 

2. Double vision 

 

Part - C 
 
Performance Standards 
 
The performance standards may include, but not limited to: 
 

Performance Standards Yes No 

Identified various types of eye disease through vision examination   

Demonstrated the skill of conducting eye examination   

 

Checklist for Assessment Activity 
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Session 3: Eye Examination 
 
In this session, you will learn about the basic eye examination processes and the procedure to conduct 

these eye tests and the various equipment used. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
In an emmetropic eye, parallel rays of light coming from infinity are 

brought to focus on the retina, with accommodation at rest.  

 

To check for eye diseases and the vision, a series of tests are 

designed. A variety of instruments are used by the doctor like shine 

bright lights.  

 

The procedures of eye examination are as follows: 

 

Check for Accommodation 

 

The adjustment of the eye for seeing at different distances can be 

referred as accommodation. Another word for focusing is 

accommodation. To see objects both near and far, accommodation 

is a change in the curvature of the lens of the eye.  

 

 
 

The objects that are close to the eye lens curves greatly to focus 

on that. The lens becomes flatter when a person focuses on the 

object far away. The object on which it is being looked at 

accommodates the eye lenses. The eye lens is controlled by the eye 

muscles which confirm whether the lens is curved or flattened by 

the ciliary muscle.  

 
 

www.nei.nih.gov 

 

Relevant Knowledge 
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Check Visual Acuity 

 

Clearness of sharp vision is visual acuity. A routine examination is 

mandatory in case of visual acuity for all patients. Several charts of 

test letters are used among which the commonly used is Snellen 

chart. From the chart the patient is seated twenty feet away. On 

the eye globe without putting pressure a clean card is placed in 

front of one eye.  

 

With progressive small letters, the chart has many small rows. The 

patient is asked to read down the chart as fast as possible. A patient 

who can read the letters on the 20/20 line from a distance of 20 

feet is said to have a vision of 20/20 vision in that eye. The same 

process is repeated for the other eye. The test should be repeated 

with his/her glasses if the patient normally wears glasses for 

distance and then the result is recorded as uncorrected or 

corrected. 

 
Check for Colour Vision  
 
Colour Vision Test:   
 
A person’s ability to distinguish primary colours and   shades. The 

test method developed by Ishihara is the most common test 

conducted. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
www.myvmc.com 
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Stilling and Hardy –Rand –Ritter 

 

A series of plates made up of dots of the primary colours are all the 

tested looks which the person has tried are printed on the 

background of similar dots in a variety of colours. A person with 

normal colour perception can identify the pattern in which the dots 

are set up. A colour deficient person cannot identify the any 

patterns. 

 

Examination of Eyes 
 
Equipment 
 
 Opaque card or occluder 

 Snellen eye chart 

 Jaeger card 

 Penlight 

 
Preparation 
 
A patient is asked to be seated with their head up matching it up 

with doctor’s eye level. 

 
Subjective Data 
 
Vision difficulty causes-Acuity which causes  

 

 Night blindness 

 Blurring  

 Blind spots 

 Floaters 

 Halos or rainbows around objects 

 Pain 

 Redness, swelling  

 Watering discharge 

 Diplopia, strabismus 

 Past hx ocular problems 

 Allergies, surgery 

 Glaucoma 

 

Testing family history 

 

 Uses of glasses or contact lenses 

 Contact care 

 Problems  

 Effectiveness 

 Last perception 

 Selfcare behaviours 

 Home and work environment 

 Last eye exam 

 Current medications 

 Systematic or topical 

 Eye medication 
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Short Answer Questions  
 
1. Explain night blindness. 

________________________________________________________ 
________________________________________________________ 
________________________________________________________ 
 
2. Describe the procedure of checking colour vision 

________________________________________________________ 
________________________________________________________ 
________________________________________________________ 
 
3. List the equipment used for eye examination 

________________________________________________________ 
________________________________________________________ 
________________________________________________________ 
________________________________________________________ 
________________________________________________________ 
________________________________________________________ 
 
 
 
Use the following checklist to see if you have met all the requirements for Assessment Activity. 
 
Part – A 
 
Differentiated between the following: 
 
1. Night blindness and glaucoma 
 
Part – B 
 
Discussed in class the following: 
 
1. Describe the various process of equipment 
2. Illustrate the use of different machines for checking the eyes 
 
Part – C 
 
Performance Standards 
 
The performance standards may include, but not limited to: 
 

Performance Standards Yes No 

Identified the equipment and instruments used for conducting eye    

Identified the different examination processes of eyes   

 

Checklist for Assessment Activity 
 

 

Assessment 
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Session 4: Visual Assessment of Eye 
 
In this session, you will learn about the basic visual assessment techniques.  
 

 

 
 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ophthalmoscopy is usually part of a routine eye test to screen for 

eye diseases. It looks at the back of the eye. The back of the eye is 

called the fundus. It consists of the following: 

 

1. Retina 

2. Optic disc 

3. Blood vessels 

 

This test may also be ordered if you have conditions that affect the 

blood vessels, such as high blood pressure or diabetes. 

Ophthalmoscopy may also be called fundus copy or retinal 

examination. 

 

Ophthalmoscopy 

 

Ophthalmoscopy is used to screen for eye diseases and conditions 

affecting the blood vessels. These include: 

 

Diabetes 

 

 Glaucoma (excessive pressure in the eye) 

 Hypertension (high blood pressure) 

 Macular degeneration (loss of vision in the centre of the visual 

field) 

 Melanoma, a type of skin cancer, in the eye 

 Cytomegalovirus (CMV) retinitis, an infection of the retina 

 Damage to the optic nerve 

 Retinal tear or detachment 

 

Preparation 

 

Doctor uses eye drops to dilate pupils. This makes them larger and 

easier to look through. However, these eye drops can make vision 

blurry and sensitive to light for a few hours. The patient should 

arrange for someone to drive you after the test. 

 

If the patient is in a job that requires a clear vision, such as 

operating heavy machinery, then the patient should arrange to take 

the rest throughout the day. The patient should also bring 

sunglasses which will protect his/her eyes from bright light after 

the pupils are dilated. 

 

If the patient is allergic to any medications, it is important that 

he/she should tell the Ophthalmologist. Eye drops should not be 

used if you could have an allergic reaction. There is also the 

possibility that some medications could interact with the eye drops. 

Therefore, it is important to tell about all medications that the 

patient is taking. Finally, the patient should tell the 

Relevant Knowledge 
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ophthalmologist if he/she has glaucoma or a family history of 

glaucoma. Most eye doctors will not use eye drops on a patient with 

suspected glaucoma. The drops can increase the fluid pressure in 

the eye too much. 

 

Procedure 

 

During the test, the patient may receive eye drops to dilate your 

pupils that may sting briefly for a few seconds. Drops can also cause 

an unusual taste in your mouth. 

 

There are three different types of ophthalmoscopy. Your 

ophthalmologist may choose to use one or more of them. The goal 

is to get the best view of the back of your eye. 

 

Direct Examination 

 

For direct examination, the patient will be seated in a chair. The 

lights in the room are turned off. The Ophthalmologist will sit across 

to the patient and uses an ophthalmoscope to examine the eye. 

 

An ophthalmoscope is an instrument that has a light and several 

small lenses for your Ophthalmologist to look through. Your 

ophthalmologist may ask you to look in certain directions as he or 

she looks at the back of your eyes. The bright light may be slightly 

uncomfortable and cause after images to appear. However, it 

should not cause pain. 

 

Indirect Examination 

 

This test allows the doctor to see the structures in the back of the 

eye in more detail. For this test, the patient will be asked to lie 

down or sit in a reclined position. The Ophthalmologist will have a 

bright light positioned around the forehead of the patient so light 

will shine in the eyes. A lens will be held in front of the eye. Then 

the doctor will hold the eye open to look into it. Pressure may also 

be applied to the eye with a small, blunt probe. This may be 

uncomfortable but should not be painful. 

 

Slit-Lamp Examination 

 

This procedure gives the Ophthalmologist the same view of your eye 

as an indirect examination, but with higher magnification. The 

Ophthalmologist sits with an instrument in front of the patient. 

There will be a place for the patient to place his/her chin and rest 

the forehead. This helps keep his/her head steady during the exam. 

A bright light will be turned on in front of the eye. The 

Ophthalmologist will use a microscope to look at the back of the 

eye. 

 

The patient may be asked to look in different directions. The 

Ophthalmologist may use his or her finger to open your eye to get 

a better view. A small, blunt probe may also be used to apply 
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pressure to the eye. This examination may be uncomfortable, but 

it should not be painful. You may see after images after the light 

turns off. They should go away after blinking several times. 

 

Risks 

 

The only risk of ophthalmoscopy is that of having a reaction to the 

eye drops. Such reactions are rare. However, they may cause: 

 

 Dry mouth 

 Flushing 

 Narrow-angle glaucoma 

 Dizziness 

 Nausea and vomiting 

 

An eye exam is a series of tests typically performed by an 

ophthalmologist or optometrist to check vision as well as structures 

and functions of the eye. Examination of the eye is of paramount 

importance in diagnosis of eye disease. 

 

Steps 

 

Check Visual Acuity (VA): VA is the acuteness or clearness of vision, 

typically checked at a distance of 20 feet (6.1 m). VA is denoted by 

a fraction, with the numerator referring to the distance at which 

the tested eye can see, compared to the denominator, which refers 

to the distance at which a normal healthy eye can see. For example, 

a visual acuity of 18/20 means that the tested eye can see at 18 

feet (5.5 m) that which a normal eye can see at 20 feet (6.1 m). 

The higher the denominator, the poorer the visual acuity of the 

tested eye. VA less than 20/20 may be due to refractive errors, or 

intrinsic eye disease. 

 

A Snellen chart is commonly used to check VA. Check the VA in each 

eye individually, by covering one eye while testing the other. Check 

VA by first having the examinee wearing his or her corrective lenses 

(VAcc, where "cc" stands for cum correction), then re-check without 

correction (VAsc, where "sc" stands for sine correction). Finally 

check each eye individually and record results. In order to pass 

DOT, the examinee must have distant visual acuity of 20/40 in each 

eye w/ or w/o corrective lenses or distant binocular acuity of at 

least 20/40 in both eyes w/ or w/o corrective lenses. 

 

Check Near Visual Acuity: Have the examinee read a card held 

approximately 14 inches (35.6 cm) away, at a normal reading 

distance. Use bright lighting during this test. Decreased near visual 

acuity may be caused by central cataracts or presbyopia, the latter 

affects most people after age 40, as the lens loses its ability to 

accommodate to focus at near with age. 

 

Test peripheral vision by checking visual field: With index finger 

horizontal to each eye, move finger to lateral side until examinee 
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can no longer see it. He/she should have at least 70 degrees of 

vision in the horizontal meridian in each eye. 

 

Test colour vision: Ask the examinee to look at the colours on 

the eye chart and identify them. 

 

Test stereopsis: For depth perception by checking binocular vision 

and monocular vision. Depth perception is the visual ability to 

perceive the world in three dimension (3D). We do not have a 

specific test for depth perception but we do ask the patient if he is 

able to see with both eyes or with just one.  

 

Eye Examination 

 

Conjunctiva: Inspect the bulbar conjunctiva (on the globe) and 

palebral conjunctiva (on the internal aspects of the lids) for blood 

vessel, secretions, or redness, and presence of any foreign bodies 

or granulations. For the bulbar conjunctiva, note the colour of the 

underlying sclera, as well as any unusual vascularity and 

prominences. 

 

Cornea: Inspect the cornea for deposits or defects, surface 

thinning, cloudiness, or presence of blood vessels invading the 

surface. Examine the tear film for both quantity and quality. Gently 

pull down the lower lid to check the quantity. A normal amount of 

tear film should leave 1-mm meniscus between the globe and the 

edge of the lower lid. Check the tear break-up time to check the 

quality of the outer oily layer to prevent evaporation. 

 

Anterior Chamber: Check for presence of white blood cells floating 

in the aqueous humour, representing iritis, by focusing a thin 

oblique beam of light on the anterior chamber and observing 

passing cells (like dust particles seen in a projector's light path). 

Look for flare (scattering of the slit lamp beam), representing 

leakage of proteins into the anterior chamber. Cells and flare 

indicate anterior chamber inflammation, e.g., from uveitis. Check 

for presence of blood (hyphema), pus (hypopyon), and foreign 

bodies. Also check for presence of pigmented cells, indicative of 

pigment dispersion syndrome or possible retinal detachment. Check 

the clarity of the aqueous humour and the depth of the anterior 

chamber. 

 

Iris: Note the colour of the iris colour, presence of any nevi or 

adhesion of the iris to the lens capsule (known as posterior 

synechiae), and any blood vessel growth on the surface (known as 

rubeosisiridis), which may occur in diabetes or other vascular 

diseases. The colour of the iris is due to amount and distribution of 

pigment in it. Persons with darker skin and hair tend to have darker 

irises as well. In albinism, the iris is translucent due to a lack of 

pigment. 

 

Lens: Look for any lens opacities or cloudiness, which may indicate 

presence of a cataract. 
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Short Answer Questions 

 
1. What is ophthalmoscopy? 

_________________________________________________________________________________
_________________________________________________________________________________
_________________________________________________________________________________
_________________________________________________________________________________ 

 
2. What is the back of the eye called? 

_________________________________________________________________________________
_________________________________________________________________________________ 
 
 
 
 
 
 

 

Do a fundus exam: To see the fundus better, dilate the pupils by 

use of an eye drop containing an agent to dilate the eyes, such as 

atropine.  

 

Carefully examine the following: 

 

Macula: Look for any drusen (tiny yellow or white build-up of 

extracellular material in Bruch's membrane of the eye; an early sign 

of macular degeneration), micro-aneurysms, pigmentations, and 

foveal reflex (movement of light in the opposite direction to the 

movement of your ophthalmoscope, a result of the concave shape 

of the fovea). Absent of a foveal reflex may be due to drusens, 

retinal pigment epithelium (RPE) migration, or swelling, and may 

indicate age related macular degeneration (ARMD). 

 

Vessels: Examine their appearance, calibre, presence of 

attenuation, and venule to arteriole diameter (normally 3:2). In 

hypertension, look for thickening of the arterioles (causing "copper-

wire" or "silver-wire" appearance) and arteriovenous nicking (AVN) 

(constriction of the venule where it crosses a rigid arteriole 

hardened from long-standing hypertension). 

 

Optic Nerve: Check for a sharp disc margin (blurred disc margin 

may indicate papilledema from increased pressure inside the 

brain), as well as any swelling or blood. Determine the cup-to-disc 

(C/D) ratio, which is used to monitor for progression of glaucoma. 

The disc is the eye's blind spot, where the optic nerve and blood 

vessels enter the retina; the cup is an area devoid of nerve fibres. 

Glaucoma destroys the nerve fibre layer of the retina, leading to 

increased cup-to-disc ratio as the disease progresses. 

 

 

Assessment  
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Use the following checklist to see if you have met all the requirements for assessment activity: 
 
Part - A 
 
Differentiated between the following: 
 
Direct and indirect examination of eye 
 
Part – B 
 
Discussed in class the following: 
 
1. What are the different types of ophthalmoscope? 
2. Describe the process of eye examination by the physician? 
 
Part - C 
 
Performance Standards 
 
The performance standards may include but not limited to: 

 
Performance Standards  Yes No 

Inspected the position of the eyes in the orbits, the eyebrows and eyelids.   

Depressed the lower lids (or spread both lids) to observe the sclera and conjunctiva.    

Inspected the cornea and iris.   

Tested the direct reaction of each pupil to a bright light.    

Examined the optic disc, retina and anterior structures.   

Performed the ophthalmoscopic examination of the eyes.   

 

 
 
 
 
  

Checklist for Assessment Activity 
 

 



129 | P a g e  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Introduction 

 
 
 
 
 
 
 
 
 

SECTOR: HEALTHCARE 

 
HSVTO206-NQ2017: Medical Records 

 
 

Student Workbook 
(Class XI) 

 
 
 
 
 
 
 
 
 
 
 
 
 



130 | P a g e  
 

 
 

 

Table of Contents 

 

SESSION 1: STORING AND MAINTAINING MEDICAL RECORDS 

 

131 

 

SESSION 2: MAINTAINING CLINICAL CARE RECORDS 

 

135 

 

SESSION 3: MAINTAINING PATIENT’S PRIVACY AND CONFIDENTIALITY   

 

138 

 

SESSION 4: LEGISLATION AND ACTS RELATED TO PRIVACY POLICY OF THE    

PATIENTS 

 

141 



131 | P a g e  
 

Session 1: Storing and Maintaining Medical Records 
 

In this session, you will learn the importance’s of tracking medical records and how to maintain them. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
A medical record helps to determine the course of health care. 

Medical records are so powerful that it shows the details of 

patient’s medical history and identifies problems. A medical record 

is a living document that tells the details of the patient and 

facilitates each encounter they have with health professionals 

involved in their care. 

To improve efficiency, co-ordination in team based, inter 

professional settings and facilitating research are done in a 

following ways: 

 Quality of Care: By providing a detailed description of 

patient’s health, status and a rationale for treatment 

decisions, medical records contribute to consistency and 

quality in patient care. 

 

 Continuity of Care: Several health practitioners use the 

medical records. A medical record is not for the personal 

memory aid for the individual physician who has created it. 

The health care providers have got the provision to access 

quickly and understand the patient’s past and current health 

status. 

 

 Assessment of Care: The fundamental components of the 

medical care are:  

 

• External reviews 

• Investigations 

• Billing reviews 

• Physician self-assessment 

 

Evidence of Care: Medical records are legal documents which 

provide civil, criminal, significant evidence in regulatory or 

administrative matters. 
 

The medical records are kept in a secure environment, where 

access is restricted to authorised personnel.  

 

Doctor usually keeps the electronic health records (EHR) which is 

similar to the personal health records (PHR). Most of the PHR 

demands the information to be done by scanning the documents or 

by typing in information by themselves. PHR are typically web 

based systems which is free and has a small subscription fee on the 

other hand the PHR is not at all connected to the employer, insurer 

and health system. Health outcomes are improved with the goal of 

increasing patient engagement offered by the organisations. 

Through a portal system many organisations offer patient a way to 

download their health information. 

 

Relevant Knowledge 
 

 

Relevant Knowledge 
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From health care providers, including doctor’s, nursing homes, 

hospitals and pharmacies and health plan a copy of medical records 

are provided as it’s a right of the patient called federally 

guaranteed right to see the medical records. 

 

It is always wise idea to keep the copies of medical records. 

 

Medical records are required during 

 

• The change of doctor 

• Get sick when one is away from home 

• If away from home and fall sick then the treatment becomes 

safer and quicker 

 

Records that should be maintained are as follows:  

 

• Medical history 

• Current health information 

• A copy of advance directive, including a living will, and a power 

of attorney. 

• Recent insurance claims and payments return records should be 

maintained. 

• After the service data, the experts’ advice to keep the records 

for another five years 

• Along with the tax returns the records can be kept for 7 years 

if they are related to tax returns. 

 

Doctors and nurses would write in the patients chart long years 

before. These notes are further added to the patient’s ever 

expanding medical file, which was physically stored on the 

premises. There was no other way to store a patient’s medical 

records until the digital age. 

 

Instead of clipboards, when they hop into the exam room table 

maximum patients expect to see computers. 

 

The majority of hospitals, doctor’s, offices and medical centers 

nationwide will store health information electronically from 2014 

onwards. 

 

Electronic health records can also be termed as electronic medical 

records. It’s a computerized collection of patient’s health details. 

A patient’s medical history, health insurance, billing information 

and other health related data are the information’s stored within 

an EHR. If a patient finds a new health provider the information can 

easily be shared among a patient’s various health providers within 

a facility, which can be quickly sent from one facility to the other. 
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Shorts Answer Questions 
 
What do you mean by Medical records? 
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 
 
What is EHR? 
__________________________________________________________________________________________
__________________________________________________________________________________________

How is information accessed? 

 

Every hospital has their own way of EHR databases which is set up 

in such a way that it is accessible in every computer. With a user 

name, password or thumbprint identification can open a patient’s 

health records, a doctor, a nurse or other health care provider 

would log into the system. By logging into their work system via; 

the internet and accessing the EHR providers can access the 

information remotely. Over the internet the systems are directly 

accessible. 

 
Some of the points that need to be considered in storing medical 

records are as follows: 

 

Important paper documents are kept in a fire proof safe 

 

Papers are prevented from the damage caused due to pests, damp 

and floods. 

 

For staff access is restricted in matter of password and encryption 

software. 

 

Passing the records to another organisation is the disposal of 

records  

 

The paper records should be shredded or incinerated. With random 

data, the CDROM’S, disks, Data should be overwritten. The hard 

drive can also be overwritten by the software with the random 

data. As such the destruction of the drive is possible and the fact 

that should be kept in mind is to keep and follow a written policy 

on that destruction of the records. 

 

If the health information is in multiple places or in format, it 

becomes very difficult to keep a track on the medical records which 

further becomes a difficult task to use it. The harder the challenge 

becomes when working with several doctors to address with several 

health concerns. 

 

Assessment  
 

 

Assessment  
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__________________________________________________________________________________________
__________________________________________________________________________________________ 

 
What is PHR? 
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 

 
What are the functions of the random data? 
 
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 
 

 

 
 
Use the following checklist to see if you have met all the requirements for assessment activity: 

 

Part – A 

 

Differentiated between the following: 

 

Medical record and demographic information record 

 

Part – B 

 

Discussed in class the following: 

 

Issues related to medical records 

 

Part - C 

 

Performance Standards 

 

The performance standards may include but not limited to: 

 

Performance  Yes No 

Demonstrated the ability to maintain written medical record using appropriate 

terminology and vocabulary 

  

  

Checklist for Assessment Activity 
 

 
 

Checklist for Assessment Activity 
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Session 2: Maintaining Clinical Care Records 
 

In this session, you will learn the role of a physician and the importance of keeping medical records. 

 

 
 

 

 
 

 

 

 

 

 

 

 

 
 

 

A medical record depends upon a number of variables that affect 

the length of a time which is kept by the physician. Factors include 

state, federal laws, association and medical board and the type of 

records. To provide information on a patient’s care to other health 

care professionals is the most important reason for keeping the 

medical records. 

 

The physicians defence in the event of a medical malpractice 

action. The physician would not be able to show that the patient 

was receiving proper care or not without proper medical records. 

Retention laws of medical records and regulations differ from state 

to state. To defend the case, it is impossible rather difficult to 

emphasize once the record is destroyed. All records that reflect the 

clinical care provided to a patient, including provider notes, nurse’s 

notes, diagnostic testing, and medication lists must be retained. 

 

The same length of time is obtained from the retain records 

obtained from the other provider. 

 

To the care provided, reference for the patient bill is reviewed. 

The care was provided or not is shown by the billing document. The 

bill can be kept for as long till the medical records is retained. To 

defend proper care, it is better to ensure the availability of records. 

 

Purposes of keeping clinical records  

 

Records of individuals are important for predicting or explaining the 

diseases that a person suffers from. Easy accessibility and 

transmittal of health data, continuity of care can be ensured 

between separate teams of service providers and between patients 

and the providers.  

 

Clinical records are useful for the following purposes: 

 

• For day today recording of patient care. 

• Storage of chronological account of the patient’s life. 

• To enable the clinician to communicate. 

• To help patients to get the illness allowance 

• To inform medico-legal investigations  

• To inform analysis of clinical activity.  

 

Electronic Medical Records (EMR) and Electronic Health Records 

(EHR) are effective application of Information and Communication 

Technology (ICT) to improve the maintenance of health records 

services in India. Electronic medical record (EMR) is a digital version 

of the paper charts in the clinician’s office. An EMR contains the 

medical and treatment history of the patients in one practice 

(single doctor clinics or hospitals). Electronic Health Record (EHR) 

Relevant Knowledge 
 

 

Relevant Knowledge 
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A. Fill in the blanks 
 
1. A medical record depends upon number of ___________________. 

2. Retention law of medical records differs from _______________ to ___________. 

3. The physicians defence in the event of medical _______________ action. 

4. The bill can be kept for as long as the bill can be _________________. 

B. Short Answers Questions 
 

1. What is medical record? 

__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 

 
2. State any three reasons for maintaining medical records. 

 
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 

 
 
 
 
Use the following checklist to see if you have met all the requirements for assessment activity. 

 
Part – A 
 
Differentiated between the following: 
 
Medical records and health records 
 
Part – B 
 
Discussed in class the following: 
 
1. Maintenance of records in an eye care clinic 
2. Purpose of maintaining clinical records.  

 
 
 

is defined by the International Organization for Standardization 

(ISO) as “a repository of information regarding the health status of 

a subject of care, in computer processable form”. EHRs are a 

summary of the various electronic medical records that are 

generated during any medical/clinical event during the lifetime of 

the individual.  EHRs can also remind providers when patients need 

immunizations, enable providers to send reminders to patients for 

preventive/follow-up care, and give providers access to clinical 

protocols.  

 

Checklist for Assessment Activity 
 

 
 

Checklist for Assessment Activity 
 

 

Assessment  
 

 

Assessment  
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Part – C 
 
Performance Standards 
 
The performance standards may include, but not limited to: 
 

Performance standards Yes No 

Described the reasons for maintaining medical records.   

Identified the various types of medical records   



138 | P a g e  
 

Session 3: Maintaining Patient’s Privacy and Confidentiality 
 

In this session, you will learn about maintaining confidentiality of the patient. 

 
 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

All healthcare personnel are required to acquire, process, store, 

retrieve and transfer clinical, administrative and financial health 

information.  Physicians must maintain the medical records of their 

patients for a period of three years.  Failure to maintain medical 

records for three years and/or refusal to provide medical records 

within 72 hours of the request constitutes professional misconduct 

rendering the Physician liable for disciplinary action. Medical 

privacy involves informational privacy (e.g., confidentiality, 

anonymity, secrecy and data security); physical privacy (e.g., 

modesty and bodily integrity); associational privacy (e.g. intimate 

sharing of death, illness and recovery); proprietary privacy (e.g., 

self-ownership and control over personal identifiers, genetic data, 

and body tissues); and decisional privacy (e.g., autonomy and 

choice in medical decision-making) (https://cis-india.org/internet-

governance/health-privacy.pdf). 

 

Confidentiality is the right of an individual to have personal, 

identifiable medical information kept private. Such information 

should be available only to the physician of record and other health 

care and insurance personnel as necessary. Patient confidentiality 

means that personal and medical information given to a health care 

provider will not be disclosed to others unless the individual has 

given specific permission for such release.  Because the disclosure 

of personal information could cause professional or personal 

problems, patients rely on Ophthalmologist to keep their medical 

information private. The most benign breach of confidentiality 

takes place when clinicians share medical information as case 

studies. When this data is published in professional journals the 

identity of the patient is never divulged, and all identifying data is 

either eliminated or changed. If this confidentiality is breached in 

any way, patients may have the right to sue. Physicians are 

increasingly being sued by patients whose information has been 

released without their permission. Even though the plaintiffs do not 

always prevail, the costs of legal action are burdensome to both 

sides. 

 

The Indian Medical Council (Professional conduct, Etiquette and 

Ethics) Regulations, 2002 (Code of Ethics Regulations, 2002) sets 

the professional standards for medical practice.  Physicians are 

obliged to protect the confidentiality of patients including their 

personal and domestic lives, unless the law requires their 

revelation, or if there is a serious and identified risk to a specific 

person and / or community or notifiable disease. 

 

The modern version of the Hippocratic Oath states: "I will respect 

the privacy of my patients, for their problems are not disclosed to 

me that the world may know.". India does not have any dedicated 

law related to privacy of medical information. Though all 

Relevant Knowledge 
 

 

Relevant Knowledge 
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1. What is patient’s confidentiality? 
 
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 
 
2. Why personal information of a patient should not be disclosed? 
 
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________ 
 
 

infringements can be complained to Medical Council of India. The 

personal information of the patient is part of the "right to privacy" 

(considered part of Article 21) and its infringement is punishable 

under law. Such a disclosure may also amount as "medical 

negligence" and be punished under the Consumer Protection Act. 

 

Privacy violations in the healthcare sector that stem from policy 

and implementation gaps include: disclosure of personal health 

information to third parties without consent, inadequate 

notification to a patient of a data breach, unlimited or unnecessary 

collection of personal health data, collection of personal health 

data that is not accurate or relevant, the purpose of collecting data 

is not specified, refusal to provide medical records upon request by 

client, provision of personal health data to public health, research, 

and commercial uses without de-identification of data and 

improper security standards, storage and disposal. The disclosure 

of personal health information has the potential to be 

embarrassing, stigmatizing or discriminatory. Furthermore, various 

goods such as employment, life, and medical insurance, could be 

placed at risk if the flow of medical information were not 

restricted. 

 

The greatest threat to medical privacy, however, occurs because 

most medical bills are paid by some form of health insurance, either 

private or public. This makes it difficult, if not impossible, to keep 

information truly confidential. Health records are routinely viewed 

not only by physicians and their staffs, but by the employees of 

insurance companies, medical laboratories, public health 

departments, researchers, and many others. If an employer 

provides health insurance, the employer and designated employees 

may have access to employee files. 

 

Both the ethical and the legal principles of confidentiality are 

rooted in a set of values regarding the relationship between 

caregiver and patient. It is essential that a patient trust a caregiver 

so that a warm and accepting relationship may develop.  

Assessment  
 

 

Assessment  
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Use the following checklist to see if you have met all the requirements for assessment activity: 
 
Part - A 
 
Differentiated between the following: 
 
1. Privacy and confidentiality 

2. Informational privacy and physical privacy 

 
Part – B 
 
Discussed in class the following: 
 
1. Why confidentiality between patient and medical personnel is important? 
2. What are the regulations that govern the confidentiality of patient’s information? 
 
 
Part - C 
 
Performance Standards 
 
The performance standards may include, but not limited to: 
 

Performance standards Yes No 

Described reasons for maintaining privacy and confidentiality of patient’s medical 

record 

  

 
 
  

Checklist for Assessment Activity 
 

 
 

Checklist for Assessment Activity 
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Session 4:   Legislation and Acts related to Privacy Policy of the Patients 
 

In this session, you will learn about the legislation to the particular disease and different acts related 

to the privacy policy of the patients. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Now that you have understood that the confidential information is 

any identifiable medical and demographic information that reveals 

the identity of the patient, such as name, address, telephone 

number, social security number, health identification number, or 

date of birth, let us now take a look at other aspect of it. There are 

certain situations where disclosure of personal health information 

is permitted. For example, in the following conditions, there are 

provisions for revealing the information subject to certain 

conditions governed by legislations:  

 

1. During referral by a doctor to another doctor or specialist 

2. When demanded by the court or by the police on a written 

requisition 

3. Under Right to Information (RTI) Act 2005 

4. When demanded by insurance companies as provided by the 

Insurance Act when the patient has relinquished his rights on 

taking the insurance 

5. When required for specific provisions of workmen's 

compensation cases, consumer protection cases, or for income 

tax authorities 

6. Disease registration 

7. Communicable disease investigations 

8. Vaccination studies  

9. Drug adverse event reporting 

 

Confidentiality is challenged in cases involving the diagnosis of 

certain diseases. A list of diseases related to confidentiality policy 

include the following: 

 

Pre-disease 

 

Pre-disease is a type of disease creep in which currently healthy 

people with risk factors for disease, but no evidence of actual 

disease, are told that they are sick. Pre-diabetes and pre-

hypertension are common examples. Labelling a healthy person 

with pre-disease can result in overtreatment, such as taking drugs 

that only help people with severe disease, or in useful preventive 

measures, such as motivating the person to get a healthy amount 

of physical exercise. 

  

Types 

 

 Infectious diseases 

 Contagious diseases 

 Food borne illness 

 

Relevant Knowledge 
 

 

Relevant Knowledge 
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Food-borne illness or food poisoning is any illness resulting from 

the consumption of food contaminated with pathogenic bacteria, 

toxins, viruses or parasites. 

 

 Communicable diseases 

 Non-communicable diseases 

 Airborne diseases 

 

Mental disorders 

 

Mental illness is a broad, generic label for a category of illnesses 

that may include affective or emotional instability, behavioural 

regulation, and/or cognitive dysfunction or impairment. Specific 

illnesses known as mental illnesses include major depression, 

generalized anxiety disorder, schizophrenia, and attention deficit 

hyperactivity disorder, to name a few. Mental illness can be of 

biological (e.g., anatomical, chemical, or genetic) or psychological 

(e.g., trauma or conflict) origin. It can impair the affected person's 

ability to work or study and harm interpersonal relationships. The 

term insanity is used technically as a legal term. 

 

Organic diseases 

 

An organic disease is one caused by a physical or physiological 

change to some tissue or organ of the body. The term sometimes 

excludes infections. It is commonly used in contrast with mental 

disorders. It includes emotional and behavioural disorders if they 

are due to changes to the physical structures or functioning of the 

body, such as after a stroke or a traumatic brain injury, but not if 

they are due to psychosocial issues. 

 

Infectious diseases 

 

In an infectious disease, the incubation period is the time between 

infection and the appearance of symptoms. The latency period is 

the time between infection and the ability of the disease to spread 

to another person, which may precede, follow, or be simultaneous 

with the appearance of symptoms. Some viruses also exhibit a 

dormant phase, called viral latency, in which the virus hides in the 

body in an inactive state. For example, varicella zoster virus causes 

chickenpox in the acute phase; after recovery from chickenpox, the 

virus may remain dormant in nerve cells for many years, and later 

cause herpes zoster (shingles). 

 

Acute disease 

 

An acute disease is a short-lived disease, like the common cold. 

 

Chronic disease 

 

A chronic disease is one that lasts for a long time, usually at least 

six months. During that time, it may be constantly present, or it 

may go into remission and periodically relapse. A chronic disease 
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Fill in the Blanks 
 
1. There are certain situations where disclosure of personal health information is permitted, for 

example when demanded by ___________________ companies, as provided by the Insurance Act 

when the patient has relinquished his rights on taking the insurance. 

2. An __________________ disease is one caused by a physical or physiological change to some tissue or 

organ of the body. 

may be stable (does not get any worse) or it may be progressive 

(gets worse over time). Some chronic diseases can be permanently 

cured. Most chronic diseases can be beneficially treated, even if 

they cannot be permanently cured. 

 

Flare-up 

 

A flare-up can refer to either the recurrence of symptoms or an 

onset of more severe symptoms. 

 

Refractory disease 

 

A refractory disease is a disease that resists treatment, especially 

an individual case that resists treatment more than is normal for 

the specific disease in question. 

 

Progressive disease 

 

Progressive disease is a disease whose typical natural course is the 

worsening of the disease until death, serious debility, or organ 

failure occurs. Slowly progressive diseases are also chronic 

diseases; many are also degenerative diseases. The opposite of 

progressive disease is stable disease or static disease: a medical 

condition that exists, but does not get better or worse. 

 

Localized disease 

 

A localized disease is one that affects only one part of the body, 

such as athlete's foot or an eye infection. 

 

Disseminated disease 

 

A disseminated disease has spread to other parts; with cancer, this 

is usually called metastatic disease. 

 

Systemic disease 

 

A systemic disease is a disease that affects the entire body, such as 

influenza or high blood pressure. 

Assessment 
 

 
 

Checklist for 
Assessment 
Activity 
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3. In an ________________ disease, the incubation period is the time between infection and the 

appearance of symptoms.  

4. An ______________disease is a short-lived disease, like the common cold. 

5. A ____________________ disease is one that lasts for a long time, usually at least six months.  

6. A ___________________ disease is a disease whose typical natural course is the worsening of the 

disease until death, serious debility, or organ failure occurs.  

7. A ______________________disease is one that affects only one part of the body, such as athlete's 

foot or an eye infection. 

8. A ________________________disease has spread to other parts; with cancer, this is usually called 

metastatic disease. 

 
 
 

Use the following checklist to see if you have met all the requirements for assessment activity: 
 
Part - A 
 
Differentiated between the following: 
 
1. Communicable diseases and non-communicable diseases 

2. Contagious diseases and organic diseases 

3. Acute and chronic diseases 

 
Part – B 

 
Discussed in class the following: 
 
Part - C 
 
Performance Standards 
 
The performance standards may include, but not limited to: 
 

Performance Standards Yes No 

Described the provisions available under various legislations and acts for challenging 

the confidentiality of patients  

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Checklist for Assessment Activity 
 

 
 

Checklist for Assessment Activity 
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Accommodation Ability of the eye to change its focus between distant objects and      

near objects. 

Accommodation Disorder It refers to the eye's ability to automatically change focus from 

seeing at a distance to seeing at near. Accommodation disorders 

have a variety of causes. Symptoms include blurred vision, double 

vision, eye strain, headache, fatigue and difficulty concentrating 

(particularly while reading). Presbyopia is an accommodation 

disorder that affects everyone if they become old enough, since its 

causes relate to the aging of the eyes. 

Acetate Type of plastic often used in eyeglass frames. 

Angle (Drainage Angle) Drainage area of the eye formed between the cornea and the iris, 

named for its angular shape, which is why you see the word "angle" in 

the different glaucoma names. 

Anterior Chamber Space between the cornea and the crystalline lens, which contains 

aqueous humour. 

Aqueous Humour Transparent fluid occupying the anterior chamber and maintains eye 

pressure. 

Bifocal Lens with one segment for near vision and one segment for far vision. 

The term "bifocal" can apply to both eyeglass lenses and contact 

lenses. 

Binocular Vision Ability of both eyes to work together to achieve proper focus, depth 

perception and range of vision. 

Bioptic Telescopic Lenses   Devices attached to glasses that provide extreme magnification, 

typically used for driving. For people with low vision who are 

qualified, telescopic lenses are attached above the driver's line of 

sight to help magnify objects such as road signs. 

Blepharochalasis Excessive, drooping eyelid skin caused by recurring swelling. 

Blepharochalasis typically occurs in young people. 

Blind Spot The beginning of the optic nerve in the retina is called the optic nerve 

head or optic disc.  Since there are no photoreceptors (cones and rods) 

in the optic nerve head, this area of the retina cannot respond to light 

stimulation.  As a result, it is known as the “blind spot,” and 

everybody has one in each eye. 

Carotenoid A pigmented substance that adds colour such as red, orange, or yellow 

to plants. Carotenoids have antioxidant properties that protect cells 

against damage from free radicals, unstable atoms that can interact 

with and break down healthy tissue in different parts of the body 

including eyes. 

Cavernous Sinus Problem The cavernous sinus is located at the base of the cranium and contains 

the carotid artery and cranial nerves. Problems in the cavernous sinus 

Glossary 
 
 

 
 

Glossary 
 
 

 

http://www.tedmontgomery.com/the_eye/retina.html#cones
http://www.tedmontgomery.com/the_eye/retina.html#rods


146 | P a g e  
 

include tumours, aneurysms and clots. Typical symptoms include 

ophthalmoplegia, chemosis and a bulging eye. You may also 

experience a red eye and vision loss. 

Ciliary Body An annular (ring-like) structure on the inner surface of the anterior 

wall of the eyeball, contained within the uveal tract and composed 

largely of the ciliary muscle and bearing the ciliary processes. 

Eyelid Either of the movable lids of skin and muscle that can be closed over 

the eyeball, providing eye protection and distribution of tears over 

the cornea while blinking. 

Fovea In the human eye the term fovea (or fovea centralis) is the "pit" in the 

retina that allows for maximum acuity of vision. The human fovea has 

a diameter of about 1.0 mm with a high concentration of cone 

photoreceptors. 

Iris The opaque muscular contractile diaphragm that is suspended in the 

aqueous humour in front of the lens of the eye; perforated by the pupil 

and continuous peripherally with the ciliary body; possesses a deeply 

pigmented posterior surface, which excludes the passage of light 

except through the pupil, and a coloured anterior surface which 

determines the colour of the eye 

Kernel When referring to a computer operating system, the kernel is the first 

section of the operating system to load into memory. 

Limbus Junction between the cornea and the sclera 

Macula The most sensitive part of the central retina, responsible for visual 

acuity and colour vision. 

Vitreous Humour The transparent gelatinous mass occupying the posterior compartment 

(the space between the crystalline lens and the retina of the eye) 

which is enclosed by a delicate hyaloid membrane; composed of water 

(99%), collagen fibrils, highly hydrated hyaluronic acid, halocytes, 

inorganic salts, sugar, and ascorbic acid; produced by halocytes 

located peripherally in the vitreous body. 
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